
 
 
 

Next-Generation System 
Analysis Model (NGSAM) 
Software Guide and 
Training Manual 
(DRAFT - Release 0.9) 

 

 

Prepared for 
U.S. Department of Energy 

Spent Fuel Disposition Campaign and 
Integrated Waste Management Planning Project 

 
Argonne National Laboratory: 

 Amanda Wagner, Chuck Olson, Michelle Kehrer,  
Evan Vander Zee, Brian Craig, and James St. Aubin 

 
Date: 28-Apr-17 

 
FCRD-NFST-M4FT-15AN0902046 

 



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual ii 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page left intentionally blank. 
 



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual iii 

 

CONTENTS 
 

FIGURES ...................................................................................................................................................... v 

DOCUMENT REVISION HISTORY ......................................................................................................... ix 

NGSAM 2.2.1.0 UPDATES ......................................................................................................................... x 
Release Notes ..................................................................................................................................... x 
Configuration Notes ......................................................................................................................... xii 

ACRONYMS ............................................................................................................................................. xiv 

1 INTRODUCTION TO NGSAM ........................................................................................................ 1 
1.1  PAT Concepts and Definitions .................................................................................................... 1 
1.2  Purpose of NGSAM User Manual ............................................................................................... 3 
1.3  Modes of Execution ..................................................................................................................... 3 

2 RUNNING A SCENARIO ................................................................................................................. 5 
2.1  Menu Options .............................................................................................................................. 7 

File Menu .................................................................................................................................. 7 
Edit Menu .................................................................................................................................. 8 
Simulation Menu ..................................................................................................................... 10 
Layout Menu ........................................................................................................................... 11 
Window Menu ......................................................................................................................... 12 

2.2  Scenario Elements ..................................................................................................................... 12 
Resources ................................................................................................................................ 15 
Resource Category .................................................................................................................. 15 
Entity Types ............................................................................................................................ 16 
Groups ..................................................................................................................................... 17 
Distributions ............................................................................................................................ 18 
Queues ..................................................................................................................................... 19 
Plans ........................................................................................................................................ 19 
Generators ............................................................................................................................... 20 
Tasks ........................................................................................................................................ 21 
Events ...................................................................................................................................... 23 
Reports .................................................................................................................................... 24 

2.3  NGSAM Scenarios Installed with the Software ........................................................................ 26 
Small Scenario Overview ........................................................................................................ 26 
Scenario Components .............................................................................................................. 27 
USFleet Scenario Overview .................................................................................................... 27 

3 REFERENCES ................................................................................................................................. 32 



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual iv 

 

APPENDICES ............................................................................................................................................ 34 
Appendix A  NGSAM Reports ......................................................................................................... 34 
Appendix B Transportation .............................................................................................................. 44 

Overview ................................................................................................................................. 44 
Scheduling (JTOM Integration) .............................................................................................. 45 
Railcars and Trains .................................................................................................................. 45 

Appendix C Allocation and Acceptance .......................................................................................... 47 
Overview ................................................................................................................................. 47 
Constraint Definition and Interpretation ................................................................................. 48 
IWMS Site Choice ................................................................................................................... 50 
User-Defined Site Allocation .................................................................................................. 50 

Appendix D Glossary ....................................................................................................................... 52 
Appendix E Installation Instructions ................................................................................................ 60 
Appendix F Web Interface for Client/Server ................................................................................... 62 

NGSAM Status page ............................................................................................................... 62 
NGSAM Scenario Page ........................................................................................................... 63 
NGSAM Login form. .............................................................................................................. 64 

Appendix G Continuous Integration ................................................................................................. 65 
Accessing NGSAM CI Release Website ................................................................................. 65 
Downloading the Current Major Stable NGSAM Release ...................................................... 66 
Downloading the Latest NGSAM Build ................................................................................. 67 
Accessing archived builds NGSAM releases .......................................................................... 68 

Appendix H Quick Edit .................................................................................................................... 70 
JTOM Configuration ............................................................................................................... 70 
MGR Configuration ................................................................................................................ 71 
Planner Configuration ............................................................................................................. 71 
ISF Configuration .................................................................................................................... 71 
Reactor Configuration ............................................................................................................. 72 

Appendix I Training Exercises ......................................................................................................... 73 
Exercise 1: Looking at Results ................................................................................................ 73 
Exercise 2: Multiple Suppliers ................................................................................................ 74 
Exercise 3: Warehouse ............................................................................................................ 76 
Exercise 4: Separate Installations ............................................................................................ 79 

  



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual v 

 

FIGURES 
 

Figure 1  Launching NGSAM ....................................................................................................................... 5 

Figure 2  Selecting a Scenario....................................................................................................................... 6 

Figure 3  Expert Edit Scenario Tree .............................................................................................................. 7 

Figure 4 File Menu Options .......................................................................................................................... 7 

Figure 5 Export Installation .......................................................................................................................... 8 

Figure 6 Export Report ................................................................................................................................. 8 

Figure 7 Edit Menu ....................................................................................................................................... 9 

Figure 8 Edit Mode ....................................................................................................................................... 9 

Figure 9  Simulation Menu ......................................................................................................................... 10 

Figure 10 Simulation Control Manager ...................................................................................................... 10 

Figure 11  Select Scenario Run Date .......................................................................................................... 11 

Figure 12 Simulation Results Summary ..................................................................................................... 11 

Figure 13  Layout Menu ............................................................................................................................. 12 

Figure 14  Window Menu ........................................................................................................................... 12 

Figure 15 Scenario with Simulation Time Frame ....................................................................................... 13 

Figure 16 Installations ................................................................................................................................. 13 

Figure 17 Movements and Time Intervals between Installations ............................................................... 14 

Figure 18 Simulation Elements in an Installation ....................................................................................... 14 

Figure 19 Resource Table Editor ................................................................................................................ 15 

Figure 20 Resource Category Editor ........................................................................................................... 15 

Figure 21 Entity Types and Entity Editor Window .................................................................................... 16 

Figure 22 Attributes .................................................................................................................................... 17 

Figure 23 Flow Attributes ........................................................................................................................... 17 

Figure 24  Groups and Group Table Editor ................................................................................................ 18 

Figure 25 Distributions ............................................................................................................................... 18 



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual vi 

 

Figure 26 Distribution Curve ...................................................................................................................... 19 

Figure 27 Plan Canvas ................................................................................................................................ 20 

Figure 28 Generators ................................................................................................................................... 20 

Figure 29 Tasks and Task Editor Windows ................................................................................................ 21 

Figure 30 Resources Required .................................................................................................................... 22 

Figure 31 Attributes Set .............................................................................................................................. 22 

Figure 32 Resources Attributes Set ............................................................................................................. 22 

Figure 33 Group Attributes Set ................................................................................................................... 22 

Figure 34 Entities Created .......................................................................................................................... 22 

Figure 35 Events Scheduled ........................................................................................................................ 23 

Figure 36 Method Calls .............................................................................................................................. 23 

Figure 37 Events ......................................................................................................................................... 23 

Figure 38  External Events .......................................................................................................................... 24 

Figure 39 Scheduled Events ........................................................................................................................ 24 

Figure 40 Creating Custom Reports ............................................................................................................ 25 

Figure 41 Update Tasks for Report ............................................................................................................. 25 

Figure 42 Update Attributes for Report ...................................................................................................... 26 

Figure 43 Initialization of JTOM ................................................................................................................ 29 

Figure 44 Adding Transportation Requests to JTOM ................................................................................. 30 

Figure 45 Schedule JTOM Execution ......................................................................................................... 31 

Figure 46 A typical Itinerary ....................................................................................................................... 44 

Figure 47 Allocation and Acceptance ......................................................................................................... 47 

Figure 48 Example Constraints file as accessed via the Edit->Allocation Constraints Menu .................... 48 

Figure 49 NGSAM Status Page .................................................................................................................. 62 

Figure 50 NGSAM Scenario Page .............................................................................................................. 63 

Figure 51 NGSAM Login Form.................................................................................................................. 64 



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual vii 

 

Figure 52 Profile Menu ............................................................................................................................... 64 

Figure 53 NGSAM CI Release Page ........................................................................................................... 65 

Figure 54 NGSAM Release Versions ......................................................................................................... 66 

Figure 55 Link to Latest NGSAM Build .................................................................................................... 67 

Figure 56 Link to Archived NGSAM Builds .............................................................................................. 68 

Figure 57 Links to Archived NGSAM Builds ............................................................................................ 69 

Figure 58  Launching NGSAM ................................................................................................................... 70 

Figure 59 JTOM Configuration Options ..................................................................................................... 71 

Figure 60 MGR Options ............................................................................................................................. 71 

Figure 61 Planner Options .......................................................................................................................... 71 

Figure 62 ISF Configuration Options ......................................................................................................... 72 

Figure 63 Reactor Configuration Options ................................................................................................... 72 
 

  



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual viii 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page left intentionally blank. 
 
  



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual ix 

 

DOCUMENT REVISION HISTORY 
Revision 
Number Effective Date Description of Revision 

N/A 
 

2/20/2015 
 

Initial creation of Nuclear Fuel Storage and Transportation (NFST) / 
Next-Generation System Analysis Model (NGSAM) Training 
Manual (Release 0) -- FCRD-NFST-M4FT-15AN0902046 

0.3 
 
 

10/30/2015 
 
 

Updated to reflect NGSAM Phase 2 – Prototype 2 (Milestone M4FT-
15AN0902043) functionality and capabilities. The revised NGSAM 
Software Guide & Training Manual (Release 0.3) contains the “Blue 
Jean” tutorial/scenario demonstrated at the Oct 14-15, 2015 Boot 
Camp. 

0.4 12/18/2015 
Revisions made based on NFST Analysts feedback from initial 
benchmark testing activities 

0.5 4/5/2016 

Addition of Appendix B Transportation, Appendix C Allocation and 
Acceptance and Appendix D NFST Glossary. Moved installation 
information to Appendix E.   

0.6 6/7/2016 

Removed references to unused functionality – world map, sense 
events, etc. Section 2.2 updated with explanation of user defined 
distributions. Section 2.3 updated with current scenarios installed 
with the software. Appendix A updated with current reports. 
Appendix C updated with more context. New appendix F for quick 
edit. Previous appendix F now Appendix G and updated so that the 
tutorial is more generic. Updated figure numbers. Changes made 
throughout to reference Phase3Proto1 instead of previously 
referenced out of date scenario.  

0.7 2/17/2017 

Added section on NGSAM 2.2.1.0 Configuration notes, as well as 
integrating the appropriate information into section 2. Added 
Appendix F: Web Interface for Client/Server and Appendix G: 
Continuous Integration.  Updated Appendix C: Allocation and 
Acceptance. Changes made throughout to reference Small scenario 
instead of previously referenced out of date scenario.  Because of the 
FY2017 reorganization, changed references to Nuclear Fuel Storage 
& Transportation (NFST) to Integrated Waste Management (IWM). 

0.8 4/14/2017 

Removed references to map. Reduced references to limited edit and 
quick edit, but did not remove them entirely since the options are still 
in the GUI. Removed original Appendix H. Updated description of 
small scenario. Minor updates throughout. Added reports to 
Appendix A.  

0.9 4/28/2017 
Reinstated Appendix H – Quick Edit. Updated Appendix H with 
further quick edit functionality. Added reports to Appendix A.  

  
  



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual x 

 

NGSAM 2.2.1.0 UPDATES 
Release Notes 

• NGSAM Simulation Framework: 
• Stand-Alone System Requirements 

 16GB RAM 
 2GB Free Space, 10GB per scenario run 
 Solid State Hard Drive 

• Client/Server supports: 
 A “shared directory” for analysts to share selected scenario with results. 
 Multiple user accounts 
 Two simulation servers, running a total of four concurrent simulations. 
 10 minute session timeout, based on activity 

 
• Continuous Integration (CI) -- The CI process for published NGSAM releases is available to 

system analysts.  Both NGSAM client and NGSAM server “builds” are generated on a nightly 
basis and accessible to analysts.  These daily client and server builds are purged with milestone 
releases (e.g., NGSAM Version 2.2.1.0). Refer to APPENDIX A for details. 

 

• The following NGSAM enhancements for Version 2.2.1.0 include: 
• Ability to start simulation from a “saved state” generated from a previous NGSAM run.  

 

• Simulation from a starting state for the GC859 data in the Unified DB snapshot (Revised 
UDB snapshot received in November from ORNL) with the following data 
enhancements: 
• Information regarding overpack storage orientation (horizontal and vertical) 
• Overpack to canister mapping 
• Transportation and storage thermal limits for every canister (i.e., zones loading 

maps) in the database.  
• Canister types (models) needed for the revised Allocation & Acceptance logic. 
• 19 Interim storage facility configurations 
• De-Aggregation data – UDB Version 3.0 contains reactor, pool and reactor-pool 

linkage data: 
o Package BWR / PWR data – types of canisters for each assembly type 
o Full Core Reserve (FCR) data for La Crosse 
o Horizontal / Vertical data 
o Complete thermal zone data. 

 
• Multiple JTOM modifications (8 identified issues discussed and distributed to 

users/analysts after the Dec 14-15 System Architecture & NGSAM team meetings held at 
Argonne).  The JTOM library version that was distributed by ORNL on 19 December 
2016 is integrated and included with this release.   

 

• A basic implementation of a Repackaging facility based on discussions with the System 
Architecture analysts. The Repackaging facility is co-located with the MGR in this 
version. 
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• De-aggregation of pools and reactor definition at reactor sites for the handling of bare 
spent nuclear fuel (SNF). Abstract use of pools and reactors has been hardened into 
actual pool and reactor entities that complete tasks during the run. The single pool per site 
logic was enhanced into “the actual number of pools per site and by type (PWR/BWR) 
for real world pools that contain both.” 

 

• Reactor-to-ISF Allocation & Acceptance – interaction between allocation planning and 
source sites to provide a more flexible allocation and acceptance process that will allow 
the user/analyst to specify particular package types accepted by different ISFs.  NGSAM 
Version 2.2.1.0 default scenarios include three ISFs with the capability to add additional 
ISFs.  

 
• ISF operation enhancements include “basic bare fuel handling at the federal ISF.” Users 

can now define the destination (either pool or storage) for incoming Direct Transport 
packages, and what package type to use to pack out of the ISF pools. 

 
Transportation routes from each reactor to the middle of Texas and to the middle of Tennessee are 
included. The three ISFs included in the default scenarios are defined as follows: Eastern ISF is the 
federal ISF and is located in Tennessee. ISF2 and ISF3 represent the private ISFs and are located in Texas 
by default. The user can change the state where each ISF is located to either Tennessee or Texas. To 
expand the set of states an ISF could be located, the developers will need routes from those ISFs to 
RPK/MGRs. 

• A number of reporting changes: 

 Summary reports from the multiple ISFs are now aggregated into a single report. 

 A new transportation report showing final loaded and unloaded mileage for each 
railcar in the scenario. 

 A new transportation report showing the cumulative railcar mileage compiled 
over time for the scenario. 

 A new Repackaging facility summary report. 

• A number of User Interface improvements, including: 

 The ability to use formatted dates as starting times for agent or resource 
generation. 

 An improved ability to change package types used at reactors over time using a 
new edit dialog. 

• Multiple bug fixes including the “ability to change the total railcars available per scenario 
in Client-Server runs.” 
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Configuration Notes 
 
This section outlines the new configuration items included in NGSAM 2.2.1.0 and how to modify them. 
 
Allocation/ISFs 
 

• The Allocation constraints spreadsheet defines constraints for the system and for the ISFs. The 
system rate constraint has been moved from the allocation spreadsheet to this spreadsheet. The 
user can define constraints on rate, capacity, and acceptable package types at each ISF. These 
constraints may change over time. 

• The allocation spreadsheet is now simpler. It has only a site name column and a site allocation 
column. After the allocation process has attempted to allocate all entries the user has defined in 
the allocation spreadsheet, it will continue with oldest fuel first allocation to all sites as rate and 
capacity constraints allow. 

 
ISF 
 

• Bare fuel packaging is controlled using the ISFPackageCreated.csv file. This file is available for 
editing in NGSAM by navigating: Edit -> ISF Package Created. 

• Incoming package handling is defined using the ISFPackageIncoming.csv file. This file is 
available for editing by navigating: Edit -> ISF Incoming Packages. 

• An ISF location can be changed by modifying the “LocationState” attribute on the 
“ISFDbDataAgent” generator for the particular ISF to be changed. Valid values are “Texas” or 
“Tennessee”. 

• Initial Pool Capacity at the Eastern ISF can be modified by going to the “Generators” tab in the 
Eastern ISF installation, and editing the “capacityInitial” value in the attributes for the two pool 
agents (PWR and BWR) generated. 

 
MGR 
 

• The MGR input processing rate is controlled in the MGR installation with the “MGRPlanner” 
agent generator. The “packagesPerYear” attribute setting controls this. 

 
Repackaging 

• The Repackaging processing rate is controlled by the number of modules available at a given 
time as well as the processing rate for the online modules. Both are controlled in the Repackaging 
installation with the “ModuleController” agent generators. Each has a generation time (the date at 
which the module becomes active) and a processing rate that can be set here. These are accessed 
by navigating to the Repackaging installation, then to Generators->ModuleController. The 
“packagesPerYear” attribute sets the input rate of the module. 

• The output package types used at each Repackaging module are also set as attributes on the 
ModuleController agents and can be changed in the generator settings. These attributes are 
“outputPackageTypeBWR” and “outputPackageTypePWR”. 

 
Reactor Sites 
 

• Packages used at reactor sites are set using the “Package Usage” editor. This defines what 
package types are in use at reactor sites over time by pool. This is accessed by navigating to: 
Edit->Package Usage. 
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• The number of days in the packing period before the pre-discharge shutdown at reactor sites can 
be modified by changing the “daysToPackBeforePredischargeShutdown” attribute value on the 
“SiteManager” agent generator in the Generators tab. 
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1 INTRODUCTION TO NGSAM 
The U.S. Department of Energy, Office of Nuclear Energy (DOE-NE), in its Integrated Waste 
Management (IWM) Planning Project, has developed tools for analyzing waste management (WM) 
systems. The results of the analyses can inform future decisions on the development and deployment of 
an integrated nuclear WM system. This document provides a brief introduction and step-by-step 
instructions for using the Next-Generation System Analysis Model (NGSAM), an integrated systems 
analysis software tool that focuses on the WM process. 

The management of (1) spent nuclear fuel (SNF) generated by the fleet of U.S. nuclear reactors, 
(2) greater than Class C (GTCC) low-level (radioactive) waste (LLW) generated during the 
decommissioning of commercial nuclear reactors, and (3) federal-government-owned SNF and high-level 
(nuclear) waste (HLW) is complex. Managing these wastes requires the use of integrated systems analysis 
software that can address all aspects of the process: waste generation, on-site storage at various locations, 
centralized or regional interim storage, transportation, and ultimate disposal.  

Alternatives for managing commercial SNF are complicated by many factors, including the large number 
of different fuel assembly types generated at nuclear reactors, the number of reactor sites involved, the 
variety of dry storage systems in use, and the different approaches used to transport SNF from the reactor 
sites. Alternatives for managing federal-government-owned SNF and HLW are complex too, because of 
the variety of different materials that are in storage, being generated, or projected to be generated at 
different sites. 

NGSAM is an agent-based, discrete-event model written in the Java programming language. Agent-based 
models, or ABMs, are a class of simulations used to study the complex interactions of individuals and/or 
organizations by defining the simple “rules” that they follow. Emergent behavior, or large-scale patterns, 
can be modeled in these simulations without having to explicitly code every interaction. Since the overall 
purpose of NGSAM is to be a logistics model, it combines discrete event simulation with agents 
(e.g., casks, canisters, railcars) that are following plans and executing tasks. The underlying NGSAM 
software is built from the Process Analysis Tool (PAT), an application developed by Argonne National 
Laboratory that lets users perform micro-level planning and analysis without having to write software 
code (i.e., “hard-code” the processing). 

Because of PAT’s generic nature, scenarios can be tailored by the analyst to emulate scenario-specific and 
site-specific activities at installations for any domain (e.g., for NGSAM, they could be activities at a 
reactor, an interim storage facility [ISF], or a mined geological repository [MGR]). The analyst also 
defines the UNF WM transportation logistics and procedures to be performed at the locations through 
NGSAM’s graphical user interface (GUI). PAT is the framework for defining the agents, resources, 
activities, and events used to model the various scenarios to be studied. It defines the tasks that agents 
need to complete at a location, the durations of the tasks, and the specific resources required to 
accomplish each task (e.g., cranes, personnel) and results in items like graphs that show the resource 
usage or demands that could signify bottlenecks. The advantage of generic modeling tool PAT is that an 
analyst can easily add new types of resources, change or add activities at locations, or add new 
installations and thereby assemble scenarios without having to program in Java. 

1.1  PAT Concepts and Definitions 
PAT concepts and definitions are described below, with existing NGSAM-specific modeling concepts 
provided in <brackets>. Items related to IWM are defined in Appendix D: 

• Agent – (aka. Entity or Entity Type).  Agents are the simulation objects that complete the tasks 
within the scenario. Attributes are defined for types of agents, and these attributes are checked in 
the simulation to help the user decide which task to do next. They can be altered as the result of 
doing a task. Agents may also be resources for tasks when other agents are completing a task. 
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NGSAM models the assemblies, casks, railcars, trucks, barges, and transportation overpacks as 
agents. The agents are the entities that make the decisions and move through the plans and tasks. 

• Course of Action -- Logic flow of NGSAM tool 
• Distribution – Distributions may be used to define the duration of a task, set an attribute of an 

agent, set a value for a resource within a task, and create (generate) agents within a simulation. 
The analyst is given a selection of the most common distributions (e.g., normal, uniform) and 
defines the properties that will shape the curve (e.g., mean, standard deviation). The analyst can 
also create custom distributions by providing a comma-separated value (.csv) file containing the 
data (e.g., assembly packing time) 

• Event – Events provide a way for agents to alter their plan of action based on a number of 
different conditions. These conditions might be resource levels, the state of some other agents, or 
the state of the agent itself. Events may be defined to execute at a certain time, or they may be 
triggered conditionally based on a change in the value of an attribute of an agent or resource. 

• Generator – Agents and resources can be generated during the simulation, either at the start or as 
the result of an agent finishing a task. 

• Groups – Groups are used to combine agents that are related <For example, combine all the 
assemblies defined to go into canisters> 

• Installation (aka. Location or Node) – An installation represents a location where agents follow 
plans and complete tasks (e.g., reactor sites, ISF, MGR, repackaging location, or railcar 
maintenance facility). It represents a container with groups of agents and activities. 

• Plan – Plans define the overall flow through a series of tasks. They consist of groups of courses 
of action.  There may be many plans in an installation. Agents flow through the tasks at an 
installation by checking the task’s attributes against the conditions in the plan to decide which 
task in the plan should be completed next. < The plans organize the tasks for the casks, 
assemblies, etc. to execute.> 

• Planner – A notional NGSAM installation that acts as the overall scenario Allocation manager. 
Unlike most PAT or NGSAM installations, the Planner does not represent a physical site, but is 
considered a notional location. This is an installation specific to the NGSAM scenarios and is not 
included in PAT. 

• Resource – Resources are anything needed to complete a particular task (e.g., people, equipment, 
supplies). Resource quantities can be Continuous (fractional amounts) or Discrete (whole 
numbers), and can be constrained or unconstrained.  <Many resources are being modeling in 
NGSAM: reactor pool capacity, empty casks, railcar availability, etc.> 

• Scenario – A scenario consists of one or more installations (e.g. reactor site(s), ISF site(s), and 
MGR site) and notional installations (e.g., Planner and Transportation).  The installations within a 
scenario contain the agents, resources, plans, tasks, events, and generators for each installation. 
<A scenario maps to the different WM cases that will be evaluated for NGSAM.>  

• Task – Tasks are the basic building blocks of the simulation. Tasks can be done by an individual 
(an individual task [IT] executed by a single agent) or by a group task [GT] (executed by all 
members of a group). A task can be executed because it is triggered by an event or as part of the 
decision logic in an agent’s plan. < All tasks are user-defined and as such, create the logic of the 
scenario run.> 

• Transportation – A notional NGSAM installation that implements the transportation aspects of 
NGSAM. In FY15 Phase 2 - Prototype 2 tool, the Transportation installation uses the Java 
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Transportation Operations Model (JTOM) to schedule trips and calculate transportation costs. 
This is an installation specific to the NGSAM scenarios and is not included in PAT. 

• Unified Group - A unified group is created from a group task [GT] when the user sets the 
“unified” flag to true, signifying that the agent moves forward to decide on the next task to do as 
a unified group. All members of the group (i.e., multiple agents) remain unified until the user sets 
the flag to false in a task that the group executes. <In NGSAM, examples would be assemblies in 
a cask, that once packed, move as a cask group. Then when the cask is loaded onto a railcar, it 
moves as a railcar group. The railcar group is disbanded, when the cask is unloaded, and the cask 
group is disbanded if/when the assemblies are removed from the cask.> All tasks that members 
perform as a group are recorded on their agenda as having executed the task, so that when 
viewing the agent traversal graph in the results, the analyst can graph the flow the agent took 
through the model. 

 

1.2  Purpose of NGSAM User Manual 
This report, an evolving NGSAM user manual with new tool functionality, is designed to help analysts 
(system analysis and decision support) navigate the tool and to support their decision-making process. 
The scope of this software guide / training manual report supports analyst training and benchmark testing 
activities for major releases of the NGSAM tool. It provides a brief overview of analyst “Quick Edit” and 
“Limited Edit” modes, as well as an in-depth tutorial for the Expert Edit mode (Appendix H).  

NGSAM is based on requirements for the WM system analysis simulation tool provided in Waste 
Management System Analysis Simulation Tool Requirements (Nutt, Puig, and Fortner 2015). Additional 
enhancements are derived from periodic workshops, research, and ongoing benchmark comparison testing 
with legacy tools.  

NGSAM’s ongoing design and development started in FY2014, and analyst enhancements and functional 
capabilities are anticipated through FY2018. The current project plan (FY2014 through FY2018) is to 
build a standalone model (this task was completed in FY2014) and migrate to the client/server (in 
FY2015 through FY2017) that could be converted to Web-based application software (Phase 3 in 
FY2018). This report contains the initial analyst training materials that reflect the current implementation 
of NGSAM Phase 2+. Revisions to this evolving document have been completed to align with major 
software deployments completed during each fiscal year of NGSAM development and maintenance 
activities. 

1.3  Modes of Execution 
The NGSAM tool may be executed in standalone mode or client/server (C/S) mode.  However, the C/S 
will be limited to the Argonne network until a hardware server upgrade is procured and configured for 
remote access. Until then, external users can VPN into the Argonne network in order to use the system. 
Appendix E explains how to install NGSAM on a computer. The same software is used for both modes; 
the execution is determined via the Simulation menu (see Section 2). Selecting Save and Run executes the 
scenario on the local machine where NGSAM is installed. The database is also stored on the machine. 
When the user selects Run on Server, the simulation will be executed on the NGSAM Simulation Server 
located at Argonne National Laboratory. The input and results are stored on the server and may be shared 
among users (user-defined sharing permissions). 
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2 RUNNING A SCENARIO 
Step 1. When the NGSAM tool is initially launched (Figure 1), the analyst can choose to edit the scenario 
in “Quick Edit,” “Limited Edit,” or “Expert Edit” mode. Currently neither Quick Edit nor Limited Edit is 
typically used by analysts.  

• Quick Edit allows the analyst to change some of the key parameters via a pop-up form. 

• Limited Edit allows the analyst to go into any task and edit duration times and resource usage but 
does not allow the analyst to create new installations or add/delete/modify plans and courses of 
action.  

• Expert Edit allows the analyst to edit/add/delete anything in the scenario as well as to copy and 
create templates. 

 

 
Figure 1  Launching NGSAM 

Step 2. Currently the install does not include a scenario with a Quick Edit or Limited Edit configuration. 
For this manual, the Expert Edit mode with be used, but not covered in depth. To learn more about the 
Expert Edit mode, please see Appendix H for an in-depth tutorial exercise and example. Pressing on the 
Expert Edit button will bring up a dialog box to select a scenario (Figure 2). Select the “Small” scenario 
and press the Open button. 
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Figure 2  Selecting a Scenario 

 
Step 3. In Expert Edit mode, the user will see a tree containing the scenario information. The top level is 
the name of the scenario with each installation listed below it. Under each installation will be areas for the 
various aspects of the installation within the scenario. The installations included within the Small scenario 
are: Braidwood, Byron, Dresdan, Eastern ISF, MGR, Planner, Transportation and Zion.  
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Figure 3  Expert Edit Scenario Tree 

2.1  Menu Options 
“File,” “Edit,” “Simulation,” “Layout,” and “Window” are the top level menus available in the NGSAM 
tool. Each of these menu items has submenu options, described in the following list. 

File Menu 

 
Figure 4 File Menu Options 

• File  New enables an analyst to create a new scenario. This option is not available in Quick 
Edit mode. 

• File  Open is used to open a different scenario. 

• File  Import lets the user import an installation into the current scenario. This option is not 
available in Quick Edit mode. 

• File  Load Server Scenario.  Copy workstation scenario from standalone workstation to a 
directory on the server. 

• File  Export Installation enables the user to export a report of the Plans/Courses of Action 
(COAs) and Tasks for an installation. The Select box will be displayed (Figure 5). 
 
Selecting the installation and pressing OK brings up the dialog in Figure 8. Select the desired 
options and the file name to export the installation to a file. The “Run All” option will export all 
of the plans of the installation; otherwise “Run Selected” will output just the selected items. 
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Figure 5 Export Installation 

 
Figure 6 Export Report 

• File  Close closes the current scenario. 

• File  Remove can be used to remove a specific installation from the scenario. This option is not 
available in Quick Edit mode. 

• File  Save saves the current scenario by overwriting it. 

• File  Save As saves the scenario to a new folder. 

• File  Save As Template saves an installation as a template, enabling it to be imported into 
another scenario. 

Edit Menu 
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Figure 7 Edit Menu 

 
Figure 8 Edit Mode 

• Edit  Edit Mode is used to switch between the three editing modes (Quick Edit, Limited Edit, 
and Expert Edit). 

• Edit  Quick Edit brings up the dialog in Figure 3 that allows the analyst to change the bare 
fuel versus dry fuel options for the installations and other options as previously discussed. 

• Edit  Allocation Priority brings up the Allocation Priority file to allow for editing. (See 
appendix C for further information) 

• Edit  Allocation Constraints brings up the constraints file to allow for editing.  (See appendix 
C for further information) 

• Edit  Vehicles brings up the unf-vehicles.csv file for editing.  

• Edit  Package Usage Packages used at reactor sites are set using the “Package Usage” editor. 
This defines what package types are in use at reactor sites over time by pool. 

• Edit  ISF Incoming Packages allows editing of the ISFPackageIncoming.csv file. 
Incoming package handling is defined using this file.  

• Edit  ISF Package Created allows editing of the ISFPackageCreated.csv file. Bare 
fuel packaging is controlled using this file. 

• Edit  Reference Data enables the analyst to pull data from the database and edit it. 

• Edit  Selected Profile. Brings up a dialog to allow for the user to change the selected profile or 
create a new one.  
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Simulation Menu 

 
Figure 9  Simulation Menu 

• Simulation  Validate will check for inconsistencies in the scenario that indicate common 
scenario development errors and will warn the user about any potential problems it finds. This 
option is most useful when using the “Expert Edit” mode. 

• Simulation  Save and Run will save the current scenario and run the simulation from the 
standalone database. Simulation status is in the “PAT Simulation Control Manager” pop-up 
window (Figure 10). The simulation can be paused at any time by selecting the “Pause” button, 
and the results can be viewed. The simulation can be resumed by selecting the “Resume” button 
at any time, and it can be stopped by selecting the “Stop” button. Do not edit the scenario when in 
Pause mode; the changes will not be considered in the currently executing simulation. 

 
Figure 10 Simulation Control 
Manager 

• Simulation  Save and Run on Server does exactly the same as Save and Run, except it runs 
from the server database.  

• Simulation  Load Simulation Results will cause the “Select Results” pop-up window to 
display and will load the results of a selected simulation run. Figure 11 shows the different 
scenario runs from which the user can choose. 
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Figure 11  Select Scenario 
Run Date 

• Simulation  Load Server Results does exactly the same as Load Simulation Results, except it 
loads the results from the server database. 

• Simulation  Load Simulation Results Summary will display the simulation results report for 
a selected installation, as shown in Figure 12. 

 
Figure 12 Simulation Results Summary 

• Simulation  Display Simulation Log displays the logging window for the selected installation. 

Layout Menu 
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Figure 13  Layout Menu 

• Layout  Restore Last Saved Layout restores the last saved window layout. Each time the 
application is closed, the current window layout is saved, and it is loaded upon restart. This 
option allows restoring the most recent saved layout. 

• Layout  Restore Default Layout allows different display windows to be 
separated/externalized and docked by clicking on the externalize icon (Figure 14, circled in red). 
This enables the user to see different displays simultaneously. The user can restore the windows 
to their original layouts by selecting the Layout  Restore Default Layout menu. 

 
Window Menu 

 
Figure 14  Window Menu 

As the user opens up reports, more options will appear in the window menu. Here is a subset of 
some of the items that will appear in this menu.  

• Window  Scenario will focus on the Scenario Window frame. 

• Window  Data will focus on the data Window frame. 

• Window  Items will focus on the Scenario Window frame. 

• Window  Course of Action will focus on the Scenario Window frame. 

• Window  Simulation Results Summary will focus on the Simulation Results Summary panel. 

 
2.2  Scenario Elements 
Clicking on the Scenario (Small) in the Scenario window to the top left of the tool will bring up the 
Simulation Time Frame window with simulation time frames, which show the start and end dates (Figure 
16). 
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Figure 15 Scenario with Simulation Time Frame 

Figure 17 shows all the installations (Reactors, ISFs, and MGRs) listed under the start and end dates. 

 

 
Figure 16 Installations 

Figure 18 shows the list of movements and the time it takes to move between the installations. Click on 
the plus sign (+) to add a new movement or select a movement. Click on the minus sign (–) to delete a 
selected movement. 
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Figure 17 Movements and Time Intervals between Installations 

In the Small scenario, the reactors (Byron, Dresden, Braidwood, and Zion), ISFs (Eastern ISF), 
Transportation, Planner, and MGR (Western MGR) are represented as installations. The Transportation 
and Planner are NGSAM installation concepts. The reason that these are modeled as installations instead 
of simply relying on the installation movement panel is that what is being modeled is more than just the 
time it takes to move between reactors, ISF, and MGR. Within the Transportation and Maintenance 
installations, plans/COAs and tasks that the railcars (as agents) perform are defined, and decisions on 
where the railcar and its contents will travel to next are made. 

Every installation contains the same set of 11 simulation elements: Resources, Resource Categories, 
Entity Types, Groups, Distributions, Queues, Plans, Generators, Tasks, Events, and Reports. These 
elements are shown as folders under the installation name (Figure 19). Each of them is described in detail 
in the text that follows. 

 
Figure 18 Simulation Elements in an Installation 
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Resources 

Resources comprise anything needed to complete a particular task (e.g., people, equipment, supplies). 
Select the Resources folder within an installation to see all the contained resources, their availability, and 
their category in the Resource Table Editor (Figure 20). Additional resources can be generated during a 
simulation. The “Amount Available” is the amount of the resource available at the beginning of the 
simulation. 

 

 
Figure 19 Resource Table Editor 

Resource Category 

Select the Resource Category folder to display the Resource Category Editor. All resources in the Small 
scenario are categorized as either “General” or “ModelInternals” (Figure 21). In Expert Edit mode, it is 
possible to create additional resource categories. 

 

 
Figure 20 Resource Category 
Editor 
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Entity Types 

To view Entity Types, select that folder under the desired installation. The Entity Editor window will 
appear (Figure 22). 

Entity Types are agents that complete the tasks within the scenario. Entity Types have Attributes 
(Figure 23) and Flow Attributes (Figure 24). Only Expert Edit mode allows attributes to be added or 
deleted, by clicking on the plus sign (+) to select an attribute or to add a new attribute and by clicking on 
the minus sign (–) to delete a selected attribute. 

Flow attributes are created when the user creates a plan, since these attributes control the flow of the 
decision logic as it moves from one task to the next. The Flow attribute is initially set to false, and when 
the task is accomplished, it is set to true so that the agent does not repeat the task but instead moves on to 
check which task should be performed next. 

 

 
Figure 21 Entity Types and Entity Editor Window 
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Figure 22 Attributes 

 
Figure 23 Flow Attributes 

Groups 

Select the Groups folder for the desired installation. The folder expands to show all groups and the Group 
Table Editor (Figure 25). Groups are defined for agents that might need to do certain tasks together. The 
groups are defined by agent attribute and can be used to filter plans or COAs so that only certain 
types/groups of agents attempt to carry out the plan. (This narrows down the number of plans an agent 
must check when calculating what to do next during the simulation.) Agents come together for a Group 
Task (GT) (defined in the Tasks tab) during the simulation, for which all members of the group must be 
present before the task is executed. These groups usually disband into individuals to decide on their next 
tasks, unless the special “unite” attribute is set to true on the task. In this case, the members remain 
together and continue on as a Unified Group (e.g., assemblies that are packed in a cask or casks that are 
loaded onto a railcar). 
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Figure 24  Groups and Group Table Editor 

Distributions 

Select the Distributions folder for the desired installation. The Task Distribution Editor is displayed 
(Figure 26). Distributions can be used to define the duration of a task, set an attribute for an agent, set a 
value for a resource within a task, and create (generate) agents within a simulation. The analyst is given a 
selection of the most common distributions (e.g., normal, triangular) and then defines the properties that 
will shape the curve (e.g., mean, standard deviation). The analyst can also create custom distributions by 
providing a comma-separated value (.csv) file containing the data (e.g., assembly packing time). The 
analyst can view the distribution curves or graphs (Figure 27) by clicking on the “View” button seen in 
Figure 26. 

 

 
Figure 25 Distributions 
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Figure 26 Distribution Curve 

In order to create a user defined distribution from a CSV file, the user would choose “UserDefined” as the 
type of distribution. This will cause a CSV file selection button to appear. Once pressed, the user can 
choose a predefined CSV file. The file should contain two columns.  The first column will specify values 
and the second column the percent probability that the value in the same row will be generated.  The 
probability percentages must add up to 100 exactly in floating point arithmetic (using double values).  
There should be a header row that labels the two columns. 
 
Queues 

Queues definitions are found in the Distributions folder. Queues are used to add more control over the 
assignment of resources within a task. When a task requires a resource and that resource is unavailable at 
that time, the requesting agent doing the task will queue up for the resource and be notified when it 
becomes available. The default ordering is a first in/first out (FIFO) ordering of the agents waiting for a 
specific task, with a pseudo-random selection of which task will be notified when agents are waiting for 
multiple tasks for the same resource. If the user wishes to define a queue, the choices are FIFO, last in/last 
out (LIFO), or agent attribute-based (i.e., the queue priority can be based on the attribute of the agents 
queuing up for a resource). 

 
Plans 

Select the Plans folder for the desired installation, then select a plan. The Plan Canvas is displayed 
(Figure 28). Plans define the overall flow through a series of tasks. There may be many plans in an 
installation. Agents flow through the tasks at an installation by checking the task’s attributes against the 
conditions in the plan to decide which task in the plan should be completed next. The plans organize the 
tasks to be executed by the casks, assemblies, etc. 

The “Step Order” tab shows a list of tasks and the order in which they should be performed. The “Trigger 
Condition” tab displays the COA trigger. 
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The “Selected Time” slider at the bottom of the COA window can be used to see the plan at various 
“slices” of time. This slider is only available after a scenario has been run or when a previous run’s results 
have been loaded by using the “Load Simulation Results” menu option.  

 

 
Figure 27 Plan Canvas 

 
Generators 

Select the Generators folder for the desired installation. The Generator Table Editor is displayed 
(Figure 29). Agents and resources can be generated during the simulation. Generators can be configured 
to execute at any time during the simulation by using the “Time Distribution.” In Expert Edit Mode, 
generators can be added or deleted by using the plus (+) and minus (–) buttons that will appear on top of 
the dialog window. 

 

 
Figure 28 Generators 
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Tasks 

View all tasks by selecting the Task folder for the desired installation. The Tasks and Task Editor 
windows will be displayed (Figure 30). Tasks are the basic building blocks of the simulation. Tasks can 
be done by an individual (an IT executed by a single agent) or by a group (a GT executed by all members 
of a group). A task can be executed because it is triggered by an event or as part of the decision logic in 
an agent’s plan. All tasks are user-defined and, as such, create the logic of the scenario run. 

 

 
Figure 29 Tasks and Task Editor Windows 

Tasks may require resources, configured in the “Resource Required” tab of the Tasks window 
(Figure 31). Users can also set attributes for the agent doing the task (Attributes Set, Figure 32), set 
attributes for some types of resources used in the task (Resource Attributes Set, Figure 33), or set 
attributes for a unified group from the members of the unified group (Group Attributes Set, Figure 34). 
Tasks can also generate agents or resources, and they are configured in the Entities Created tab 
(Figure 35). In addition, tasks can schedule events, which are configured in the Events Scheduled tab 
(Figure 36). The Method Calls tab (Figure 37) allows tasks to call custom Java code. In NGSAM, some 
tasks call special Java methods for doing calculations, such as creating the assembly discharge schedule 
for the reactors. 
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Figure 30 Resources Required 

 
Figure 31 Attributes Set 

 
Figure 32 Resources Attributes Set 

 
Figure 33 Group Attributes Set 

 
Figure 34 Entities Created 
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Figure 35 Events Scheduled 

 
Figure 36 Method Calls 

Events 

Events provide a way for agents to alter their plan of action based on a number of different conditions. 
These conditions can be resource levels, the state of some other agents, or the state of the agent itself. 
Events may be defined to execute at a certain time, or they may be triggered conditionally based on a 
change in the value of an attribute of an agent or resource. There are two types of Events (External Events 
and Scheduled Events), as shown in Figure 38. 

 

 
Figure 37 Events 

External Events (Figure 39) may be used to set attributes in an agent (Entity Type). External Events can 
also schedule another event. In this way, the user can set up a recurring event during the simulation. In 
this example, the “ReactorManager” agent sets the flow attribute for its task “Discharge Assemblies” to 
false. This also triggers the agent to look at its plans to determine what to do next. The ReactorManager 
will redo the Discharge Assemblies task, which in this scenario, creates the assembly agents that will be 
discharged for the current year and adds them to the simulation to be processed. The Discharge 
Assemblies task schedules the “Activate Manager” event for the next year to initiate this process for each 
year in the simulation. 
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Figure 38  External Events 

Scheduled Events (Figure 40) are used to specify a simulation time for an External Event to be initiated. 
The time could be an “Interval” (minutes or days from simulation start time) or chosen from a 
“Distribution.” 
 

 
Figure 39 Scheduled Events 

Reports 

The Reports section is intended for users to create custom reports for a scenario installation and has been 
enhanced in current scenarios. The reports that can be generated currently are listed in Appendix A, and 
the Notes column has a description of how to generate each report. 
 
In Expert Edit Mode, a user can add a new report or update existing reports. Add a new report by clicking 
on the plus sign (+) in the Items window and entering the name of a new report (Figure 41). To customize 
a report, select a report in the Items window and add/remove tasks (Figure 42) and attributes (Figure 43). 
Each time an agent performs one of the selected tasks, all of the selected attributes will be logged to the 
specified report file in .csv format. 
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Figure 40 Creating Custom Reports 

 

 
Figure 41 Update Tasks for Report 
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Figure 42 Update Attributes for Report 

 
2.3  NGSAM Scenarios Installed with the Software 

There are three full scenarios that come with NGSAM: the “Small” scenario, the “USFleet” scenario and 
the “Shutdown” scenario. The Small scenario models fuel movement from four selected reactor sites in 
Illinois, while the USFleet scenario models all reactor sites in the United States. Both scenarios have 
similar logic, but the USFleet scenario takes a significantly longer time to run due to the size. The 
Shutdown scenario contains reactor sites that have shutdown. The scenarios use identical allocation and 
acceptance logic (see Appendix C), dry storage cask loading logic, and transportation planning using 
JTOM (see Appendix A). 
 
Small Scenario Overview 

The Small scenario includes four reactor installations, three ISFs, one Repackaging facility, one FMF, and 
one MGR. In addition to these physically located installations, this scenario includes two additional 
notional installations that are related to modeling the (a) Transportation (see Appendix B) and (b) 
Planning installations. The Planning installation is primarily responsible for performing allocation among 
the reactors in the scenario. 

 

The overall logistics in this scenario are defined such that the assemblies that are ready for packing and 
transport originate at one of the active reactor sites. Transportation assets are deployed to the reactors, 
where the assemblies or dry storage canisters are packed and loaded onto the railcar. Processing of the 
loaded asset then transfers back to the transportation installation; then by executing the plans and COAs at 
the transportation installation, the railcar is directed to one of the ISFs, which was pre-determined by 
allocation planning. After this, the railcar arrives at the physical destination installation and proceeds to 
execute plans and tasks at that installation. Packages are transferred from the ISFs to the Repackaging 
facility and from the Repackaging facility to the MGR in a similar fashion. 

The main purpose of this scenario is to demonstrate the modeling concepts used in the USFleet scenario, 
but on a smaller scale so that runtimes are more manageable. The dates are defined such that the scenario 
begins at the beginning of A.D. 2013 and runs for 87 years, stopping at the beginning of A.D. 2100. 
Assemblies and Packages that pre-date 2013 are loaded in at the start of the simulation. 

Transportation in the scenario is modeled by using itineraries and legs. An itinerary represents the path 
that will be taken by a particular asset when the asset is given a particular task. An itinerary is made up of 
legs. Each leg represents the asset traveling from one location to another location. For example, a railcar 
may be tasked to pick up UNF from Crystal River and bring that fuel to the ISF. Since the railcar is 
currently located at the maintenance facility, accomplishing the task might involve traveling from the 
maintenance facility to Crystal River (the first leg), traveling from Crystal River to the ISF (the second 
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leg), and returning to the maintenance facility (the final leg). These three legs make up the itinerary of the 
railcar for the task of bringing UNF from Crystal River to the ISF. 

In all scenarios, the itineraries and legs are created automatically by the software through its use of 
JTOM. JTOM uses route data produced by the START tool to represent the transportation network. 
Currently, in NGSAM/JTOM, only rail routes are defined, and of those, only those between the reactors, 
ISFs and the MGR within this scenario are defined. 

 

Scenario Components 

The types of agents modeled in this scenario are the same as those in the Generalized Transport case. The 
NGSAM-specific agents that are modeled within and move between installations include: 
 

• Fuel rod assemblies, 

• Canisters, 

• Transportation casks, 

• Railcars, and 

• Grouped agents: 

o Assemblies within canisters, 

o Canisters within transportation casks, and 

o Loaded railcar (cask with railcar). 

Within the scenario, the dry storage cask models that are used are defined in the Generators tree. There 
are currently three types of casks that are defined, each being introduced at a different time. For example, 
the Braidwood reactor specifies that the MPC-32 package type be used. In this case, the same package is 
used for the entire scenario. The package is listed three times as a convenience for the user for if they 
would like to change the package type to be used at some point in the simulation. 
 
To change the package type used at a given time in the simulation, simply change the package type to the 
desired value and the distribution value to the desired time. When the simulation reaches the desired time, 
then that reactor will switch over to using the new package type.  
 
For bare fuel, the cask used is defined in the “Railcar Chose Bare Fuel at Reactor Site” task in the 
Railcar->ProcessRailcar course of action. These packages get their performance attributes from the 
database. 
 
USFleet Scenario Overview 

The USFleet scenario is the same as the Small scenario, except that it contains installations for all reactors 
in the U.S. nuclear reactor fleet. Because of this, the USFleet scenario takes a significantly longer time to 
run. This scenario is used for actual analysis, while the Small scenario is more appropriate for 
demonstrations, educational purposes, and debugging. 
 
The agent types, resources, timeline, plans, courses of action, transportation network, and almost all other 
components are the same as in the Small scenario. The transportation fleet is larger. 
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Allocation and Acceptance 

The current design of NGSAM allows for complete flexibility of allocation input. Allocation input to 
NGSAM consists of an excel worksheet defining which sites are allocated what amounts of metric tons of 
uranium (MTU) per year of the simulation along with a number of agent attribute settings. In addition, the 
report of acceptance (receipt) of SNF after a simulation has been completed is formatted in a way that 
closely resembles the allocation input worksheet. An analyst can easily modify the acceptance output of 
one simulation to serve as the allocation input of another simulation. This mirrors the functionality of 
current systems analysis tools (e.g., TSL-CALVIN) and allows complete freedom in defining system 
allocations. 

 

There are three primary settings that control the operation of the allocation and acceptance process. First, 
each reactor has a setting for how it will propose fuel that it would like to ship. This setting is accessed in 
each reactor’s AllocationRequestor agent Generator. The AllocationRequestor agent has an attribute 
called “AllocationProposalAlgorithm” which specifies what SNF will be proposed to the Planner for 
allocation. 

 

Second, the Planner agent in the Planner installation has an attribute called “allocationAlgorithm” that 
specifies how the Planner will allocate fuel to ship from each reactor. The value of this attribute is set in 
the Planner agent Generator. There are a number of possible values for this attribute. The “Local” value 
causes the allocation spreadsheet to be used to determine allocation priority for each reactor. Reactors that 
are listed higher on the spreadsheet are given first priority in allocation. Reactors that are lower on the 
spreadsheet are given last priority.  

 

The “Global…” values cause the Planner to ignore the allocation spreadsheet for allocation priority (but 
not for the allowed fleet and reactor maximums). These values cause the planner to evaluate all proposed 
allocations across all reactors and give priority in allocation according to the reactors that have fuel fitting 
the algorithm name. For example, “GlobalOldestFuelFirst” will cause the planner to give priority to 
reactors that house the oldest assemblies in the fleet of reactors.   

 

Third, each reactor has a setting for how it will fulfill the given allocation it receives from the Planner. 
The “AcceptanceAlgorithm” attribute on the ReactorManager agent specifies how each reactor should 
choose fuel to ship to its destination. For example, “Dry Packages with oldest assemblies, then packable 
wet assemblies” will cause the reactor to choose to send its fuel that is in dry storage first, and only when 
that is exhausted will it send any fuel that is contained in the reactor’s pool. 

 

Refer to Appendix C for diagrams related to this topic. 

 

Dry Storage Cask Loading 

NGSAM software analyzes various alternative SNF management options and provides quantitative and 
qualitative merits for each of these options to inform decision-making. The current SNF management 
strategy relies on dry storage systems used at reactor sites to allow continued operation of the nation’s 
nuclear fleet. Therefore, for integrated SNF management, NGSAM software requires a dry storage 
loading algorithm to simulate the loading of future dry storage casks at reactor sites according to dry 
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storage system requirements specified in the Certificates of Compliance (COCs).  Dry storage loading 
logic/algorithm details can be found in (Banerjee and Jarrell, 2015). 

 

JTOM Integration 

In order to have transportation assets load and move casks between installations, the JTOM planner is 
integrated into the NGSAM simulation. All the inputs needed to initialize the JTOM engine come from 
the Unified database (stored within the NGSAM database), or from separate configuration files. In 
particular, the transportation network that JTOM uses and the transportation vehicle fleet that is modeled 
are defined in separate files. The transportation network is contained in the routeData folder of the 
NGSAM installation. 
 
Another item of note is that the only mode of transport is railcars, since the START routes available to the 
simulation are only rail routes. JTOM uses the buffer and escort cars for scheduling and costing purposes, 
but only the rail cask cars are modeled as agents within the simulation. The railcar fleet is defined in the 
unf-vehicles.csv file of each scenario. 
 
All the planning is done within the Transportation Installation. Figure 44 shows the Scheduling Plan with 
the Initialization COA. Clicking on the “Receive Transportation Init” task and then on “Method Calls” 
shows the Java method that is called whenever an agent executes this task. The JTOM engine is initialized 
with all the static data it needs between scheduling calls. 
 

 
Figure 43 Initialization of JTOM 

In Figure 45, the Request Reception COA is shown within the Scheduling Plan. The Transportation 
installation expects to receive transportation requests from every rector in the scenario for each 
transportation planning period. In order to know when all expected requests are received (one for each 



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual 30 
 

 

reactor), “processing slot” resources are created. The number of processing slots available will equal the 
number of reactors that are in the simulation. In the Request Reception COA, if there is a processing slot 
available, then the transportation request is added to the JTOM module. If a transportation request is not 
available, this means that the request being processed is the final request that is to be expected during the 
planning period. In this case, the request is added to the JTOM module, and the JTOM scheduling process 
is run.  
 
The current planning period for transportation is 1 year. Therefore, JTOM will be run every simulation year. It 
is called from the “Schedule Transportation” task in the Request Reception COA (see Figure 46). At this 
time, the simulation executes the JTOM module, which will attempt to schedule trips for the pending 
transportation requests in that time period. For trips that can be completed within the time period, 
itineraries and legs are created based on those trip plans and inserted into the NGSAM simulation as 
agents. These agents then start executing their appropriate plans (under Itinerary and Leg COAs, 
respectively). 
 

 
Figure 44 Adding Transportation Requests to JTOM 
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Figure 45 Schedule JTOM Execution 

 
Appendix A provides a listing of new and existing reports in NGSAM Phase 2 – Prototype 2. 
 
 
CONCLUSION 
 
The NGSAM Software Guide and Training Manual reflects current functional and operational 
logic/algorithms existing in the NGSAM version 2.1.5.0 software.  This evolving report can be referenced 
by System Analysts to assist their TSL-CALVIN vs. NGSAM Benchmark testing, as well as support their 
ongoing analyses reporting requirements.  
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APPENDICES 
Appendix A  NGSAM Reports 
 

# Report Title 
Report 
Format 

Analyst Purpose/ 
Short Description of How Used Notes 

1 RX All Table 
(exportable to 
.csv and .xls) 

Shows shipping and storage 
activities, aggregated across all 
reactors, by year. This is output 
from one of the four TSL-
CALVIN (TSL) reports via the 
Detailed Output and then the 
Facility Data buttons. 

To display:   Analyst can right-
click on any part of a scenario, in 
the Table of Contents, and choose 
this report in the TSL Reports 
submenu. Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 

2 RX Detail Table 
(exportable to 
.csv and .xls) 

Shows shipping and storage 
activities, for each reactor, by 
year. This is output from one of 
the four CALVIN reports via the 
Detailed Output and then the 
Facility Data buttons. 

To display:   Analyst can right-
click on any part of a scenario, in 
the Table of Contents, and choose 
this report in the Calvin Reports 
submenu. Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 

3 Shipment 
Summary 

Table 
(exportable to 
.csv and .xls) 

Shows number of truck and rail 
shipments of casks between all 
facilities. Typically used only to 
get transportation operations 
model (TOM) results. 

To display:   Analyst can right-
click on any part of a scenario, in 
the Table of Contents, and choose 
this report in the Calvin Reports 
submenu Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 

4 Final 
Inventory 
Summary 

Table 
(exportable to 
.csv and .xls) 

Shows the final number of dry 
packages, dry metric tons of 
heavy metal (MTHM), dry 
assemblies, wet MTHM, and wet 
assemblies for each installation. 

To display:   Analyst can right-
click on any part of a scenario, in 
the Table of Contents, and choose 
this report in the Calvin Reports 
submenu Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 

5 Final 
Assembly 
Disposition 

Table 
(exportable to 
.csv and .xls) 

Shows the DBID, reactor, 
package, package type, pool, 
discharge date, metric tons of 
heavy metal (MTHM), and heat 
for each assembly.  

To display:   Analyst can right-
click on any part of a scenario, in 
the Table of Contents, and choose 
this report in the Calvin Reports 
submenu Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 
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6 Site 
Shutdown 
Summary 

Table 
(exportable to 
.csv and .xls) 

Shows, for each reactor, the last 
discharge date, pool shutdown 
delay years, if the pool has shut 
down, and if the pool is empty. 

To display:   Analyst can right-
click on any part of a scenario, in 
the Table of Contents, and choose 
this report in the Calvin Reports 
submenu Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 

7 X ISF (e.g., 
Eastern ISF) 

Table 
(exportable to 
.csv and .xls) 

Shows shipping and storage 
activities, for this ISF, by year 
(basically the same as RX_DET). 
Used to examine cans/casks that 
are arriving, going into dry 
storage, coming out of dry 
storage, and being shipped from 
the ISF. This form is useful when 
repackaging is being done at the 
ISF; that is, the number of cans 
that arrive can differ from the 
number going into dry storage if 
repackaging is done upon ISF 
receipt (i.e., upon arrival). 
Similarly, the number coming 
out of dry storage can be 
different than the number being 
shipped if repackaging is being 
done at ISF shipping (i.e., on the 
way out the door). This is output 
from one of the four CALVIN 
reports via the Detailed Output 
and then the Facility Data 
buttons. 

To display:   Analyst can right-
click on any part of a scenario, in 
the Table of Contents, and choose 
this report in the Calvin Reports 
submenu. Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 

8 MGR  Table 
(exportable to 
.csv and .xls) 

Shows shipping and storage 
activities, for the MGR, by year 
(basically the same as RX_DET). 
The activity called "Shipped" is 
really "disposal" (i.e., "bury it in 
the ground"). The MGR arrival 
report isn't typically used in 
analyses, but it is used 
sometimes and is good for some 
error checking. More important, 
at some point, it will be used a 
lot. For now, the focus has been 
on the logistics side (e.g., stuff 
coming into and going out of the 
different facilities). This is one of 
the four CALVIN reports output 
via the Detailed Output and then 
the Facility Data buttons. 

To display:   Analyst can choose 
it from the Reports->Calvin 
Reports menu 
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9 Cask 
Allocation 
for X (e.g., 
Cask 
Allocation 
for Zion, or 
Cask 
Allocation 
for All) 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows how many casks were 
proposed (by the reactor to the 
planner), allocated (by the 
planner), and accepted (by the 
reactor—i.e., shipped). Can be 
generated for each installation or 
across all installations. This 
allows the analyst to determine, 
modify, and analyze alternative 
allocation strategies (by looking 
at the allocation, modifying it, 
and then running it again). 

To display:   Analyst can right-
click on any part of an 
installation, in the Table of 
Contents, and choose this report 
for that installation. Or, choose 
Cask Allocation for All in the 
Scenario Results Reports 
submenu. Note: This report may 
need to be modified based on 
Casey's Macro calculation 
spreadsheet. 

10 Dry Storage 
Inventory by 
Reactor 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows the transfer of assemblies, 
metric tons of heavy metal 
(MTHM), and casks into dry 
storage, at a reactor, or out of dry 
storage. These are some things 
the system wants to monitor and 
try to control. For example, one 
of the alternative allocation 
strategies focuses on eliminating 
new dry storage after the ISF is 
up and running. There are three 
types for this report: assemblies, 
MTHM, or casks. 

To display:   Analyst can right-
click on any part of the Table of 
Contents, and choose any of these 
reports in the Scenario Results 
Reports submenu. 

10 Allocation 
Results 

Excel file Provides a workbook with a 
spreadsheet for each year of the 
simulation. Each sheet reports 
the cask allocation at each 
reactor. 

To display:   Analyst can right-
click on any part of the Table of 
Contents, and choose this report 
in the Scenario Results Reports 
submenu. 

11 Resources: 
Graph 
Instantaneou
s Resource 
Usage 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows how much a resource was 
being used at a given time and 
how much of the resource was 
available during the run. Can be 
used to determine when a 
resource was used during the run 
and how much of the available 
resource was used. 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 

12 Resources: 
Graph 
Cumulative 
Resource 
Usage 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows how much a resource was 
used over the course of the whole 
run and how much of the 
resource was available. Can be 
used to determine the total usage 
of the resource at a given time. 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 

13 Resources: 
Graph 
Hourly 
Resource 
Requested 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows the amount of a resource 
requested by hour and the 
number of resource requests that 
cannot be filled per hour (number 
waiting). Can be used to 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 
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determine the demand for a 
resource at a given time. 

14 Resources: 
Graph 
Hourly 
Resource 
Usage 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows the amount of a resource 
that was used per hour. Can be 
used to determine when the 
resource was most frequently 
used. 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 

15 Resources: 
Graph 
Hourly 
Resource 
Wait 

Graph/Table 
(exportable to 
.csv and .xls) 

Is similar to the Graph Hourly 
Resource Requested report, in 
that it shows when there is more 
demand for a resource than the 
amount that is available. Can be 
used to determine when there is 
high demand for a resource. 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 

16 Resources: 
Graph Daily 
Resource 
Requested 

Graph/Table 
(exportable to 
.csv and .xls) 

Is the daily version of Graph 
Hourly Resource Requested. 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 

17 Resources: 
Graph Daily 
Resource 
Usage 

Graph/Table 
(exportable to 
.csv and .xls) 

Is the daily version of Graph 
Hourly Resource Usage. 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 

18 Resources: 
Graph Daily 
Resource 
Wait 

Graph/Table 
(exportable to 
.csv and .xls) 

Is the daily version of Graph 
Hourly Resource Wait. 

To display:   Analyst can right-
click on any resource listed in an 
installation's Resources list, in the 
Table of Contents, and choose 
this report (for that installation's 
resource). 

19 Resource 
Categories: 
Graph 
Instantaneou
s Resource 
Category 
Usage 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows the Instantaneous 
Resource Usage for each 
resource in the Resource 
Category on the same graph. Can 
be used to determine how the 
resources in a category that were 
used at a given time compare 
with one another. 

To display:   Analyst can right-
click on any category listed in an 
installation's Resource Categories 
list, in the Table of Contents, and 
choose this report (for that 
installation's resource category). 
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20 Resource 
Categories: 
Graph 
Cumulative 
Resource 
Category 
Usage 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows the Cumulative Resource 
Usage graph for each resource in 
the Resource Category on the 
same graph. Can be used to 
determine how the resources in a 
category that were used over the 
whole scenario compare with one 
another. 

To display:   Analyst can right-
click on any category listed in an 
installation's Resource Categories 
list, in the Table of Contents, and 
choose this report (for that 
installation's resource category). 

21 Entity 
Types: 
Agent 
Traversal 

Table 
(exportable to 
.csv and .xls) 

Displays information about each 
task completed by the selected 
agent, including Wait, Start, 
Stop, and Traversal times. Can 
be used to see what tasks were 
completed by an agent during the 
run and if the agent was used as a 
resource. 

To display:   Analyst can right-
click on any entity type listed in 
an installation's Entity Types list, 
in the Table of Contents, and 
choose this report (for that 
installation's entity type). 

22 Entity 
Types: 
Agent 
Traversal 
Graph 

Graph 
(exportable to 
gif) 

Provides a visual representation 
of the tasks completed by a 
selected agent during the run. 
Shows the plan under which the 
tasks were completed and the 
state that the agent was in while 
doing the task (Agent, Resource, 
Group, etc.). Can be used to see 
how the agent stepped through 
the run. 

To display:   Analyst can right-
click on any entity type listed in 
an installation's Entity Types list, 
in the Table of Contents, and 
choose this report (for that 
installation's entity type). 

23 Entity 
Types: 
Agent 
Timeflow 

Timeline/ 
Calendar/List/
Graph/Table 
(exportable to 
.csv and .xls) 

Provides a detailed visual 
representation of the agent's tasks 
completed during the run. Can be 
modified by the user to select a 
category. Can be used to see 
detailed information about task 
completion during the run. 

To display:   Analyst can right-
click on any entity type listed in 
an installation's Entity Types list, 
in the Table of Contents, and 
choose this report (for that 
installation's entity type). 

24 Plans 
Subtype: 
Agent 
Traversal for 
X 

Table 
(exportable to 
.csv and .xls) 

Shows the task traversal times 
through a plan taken by an agent. 
Can be used to determine what 
tasks in the given plan were 
completed by the agent and when 
they were completed. 

To display:   Analyst can right-
click on any Plans subtype listed 
in an installation's Plans list, in 
the Table of Contents, and choose 
this report (for that installation's 
plan subtype). 

25 Plans 
Subtype: 
Agent 
Traversal by 
COA for X 

Table 
(exportable to 
.csv and .xls) 

Shows Processing Wait and 
Processing Time taken by an 
agent by task. 

To display:   Analyst can right-
click on any Plans subtype listed 
in an installation's Plans list, in 
the Table of Contents, and choose 
this report (for that installation's 
plan subtype). 
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26 Plans 
Subtype: 
Agent 
Traversal 
Graph by 
COA for X 

Graph 
(exportable to 
.gif) 

Provides a visual representation 
of the tasks in the plan that were 
completed by a selected agent 
during the run. Shows what state 
the agent was in for the task 
(Agent, Resource, Group, etc.). 
Can be used to see how the agent 
stepped through the plan. 

To display:   Analyst can right-
click on any Plans subtype listed 
in an installation's Plans list, in 
the Table of Contents, and choose 
this report (for that installation's 
plan subtype). 

27 Plans: Task 
Duration 
Report for 
COA 

Table 
(exportable to 
.csv and .xls) 

Shows the time spent in each 
task of the COA. Can be used to 
determine how long the plan was 
used. 

To display:   Analyst can right-
click on any plan listed in an 
installation's Plans subtype list, in 
the Table of Contents, and choose 
this report (for that installation's 
plan). 

28 Plans: Graph 
Traversal 
Time: X 

Graph/Table 
(exportable to 
.csv and .xls) 

Is a bar graph of traversal time 
through the COA. Shows the 
number of agents that took X 
amount of time to complete the 
COA. Can be used to determine 
common run times through the 
COA. 

To display:   Analyst can right-
click on any plan listed in an 
installation's Plans subtype list, in 
the Table of Contents, and choose 
this report (for that installation's 
plan). 

29 Plans: Show 
Agent 
Timeline 
Table: X 

Table 
(exportable to 
.csv and .xls) 

Shows the number of minutes 
spent on each task by each agent 
that entered the COA. Can be 
used to compare task completion 
times and traversal times of 
agents. 

To display:   Analyst can right-
click on any plan listed in an 
installation's Plans subtype list, in 
the Table of Contents, and choose 
this report (for that installation's 
plan). 

30 Task: Graph 
Processing 
Distribution: 
X 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a graph of the Processing 
time taken by each agent that 
completed the task. Can be 
particularly useful for seeing the 
completion times for tasks with 
variable Processing times. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

31 Task: Graph 
Wait 
Distribution: 
X 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a graph of the Wait time 
for each agent that waited in the 
task. Can be used to see how 
many agents waited in the task 
and how long Wait times were 
for the task. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

32 Task: Graph 
Traversal 
Distribution: 
X 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a graph of the Wait time 
plus Processing time for each 
agent in the task. Can be used to 
see how much total time that 
agents spent on the task. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

33 Task: Graph 
Traversal 
and Wait 
Distribution: 
X 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows both the Graph Waiting 
Distribution: X and the Graph 
Traversal Distribution: X graphs 
on the same graph. Can be used 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
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to compare Wait time to total 
Traversal time. 

this report (for that installation's 
task). 

34 Task: Graph 
Waiting 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a graph of the number of 
agents waiting in the task at a 
given time. Can be used to see 
how frequently agents were 
waiting in a task and how many 
agents remained waiting in the 
task at the end of the simulation. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

35 Task: Graph 
Processing 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a graph of the number of 
agents processing in a task at a 
given time. Can be used to see 
how often agents processed in 
the task and if any agents were 
still processing in the task at the 
end of the simulation. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

36 Task: Graph 
Completed 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a graph of the total 
number of agents that have 
completed the task at a given 
time. Can be used to determine 
how often a task was completed 
and how many agents completed 
the task. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

37 Task: Graph 
All 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a combination of the 
Graph Waiting, the Graph 
Processing, and the Graph 
Completed graphs on the same 
graph. Can be useful for 
comparing the number of agents 
that are waiting with the number 
that completed a task and seeing 
how a task was used throughout 
the simulation. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

38 Task: Graph 
All 
(Cumulative) 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows a cumulative version of 
the Graph All graph. Can be used 
to see the cumulative amount of 
waiting done in a task during the 
simulation. Can also be used to 
compare the amount of waiting 
with the cumulative amount of 
agents that completed the task. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 
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39 Task: Agents 
Processed 
Table 

Table 
(exportable to 
.csv and .xls) 

Shows a table with a row for 
each task completed during the 
simulation, with each row 
showing the name and type of 
agent, if the agent was a 
resource, and the timing of the 
agent's traversal. Can be used to 
see what agents completed the 
same task multiple times, how 
long specific agents waited in the 
task, and when the agents entered 
and exited the task. 

To display:   Analyst can right-
click on any task listed in an 
installation's Tasks list, in the 
Table of Contents, and choose 
this report (for that installation's 
task). 

40 COA Graph Graph 
(exportable to 
.gif) 

Shows the flow of tasks that are 
involved in the plan. 

To display:   Analyst can right-
click on any Plans subtype listed 
in an installation's Plans list, in 
the Table of Contents (for that 
installation's plan subtype). 

41 
 

Transfer Into 
Dry Storage 
At Reactor 

CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

Custom report: Shows a table of 
origin site, origin reactor, 
number of assemblies, metric 
tons of heavy metal (MTHM), 
and percent cask by MTHM for 
each cask being transferred from 
dry storage to offsite transport at 
the reactor. Can be generated for 
each installation or across all 
installations. 

To display:   Analyst can right-
click on 
transferIntoDryStorageAtReactor.
csv, listed in an installation’s 
Reports list, in the Table of 
Contents. 

42 
 

Transfer Out 
Of Dry 
Storage At 
Reactor 

CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

Custom report: Shows a table of 
origin site, origin reactor, 
number of assemblies, metric 
tons of heavy metal (MTHM), 
and percent cask by MTHM for 
each cask being transferred from 
wet to dry storage at the reactor. 
Can be generated for each 
installation or across all 
installations. 

To display:   Analyst can right-
click on 
transferOutOfDryStorageAtReact
or.csv, listed in an installation’s 
Reports list, in the Table of 
Contents. 

43 Transfer 
From Pool 
To Offsite 
Transport At 
Reactor 

CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

Custom report: Shows a table of 
origin site, origin reactor, 
number of assemblies, metric 
tons of heavy metal (MTHM), 
and percent cask by MTHM for 
each cask being transferred from 
the pool to offsite transport at the 
reactor. Can be generated for 
each installation or across all 
installations. 

To display:   Analyst can right-
click on 
transferFromPoolToOffsiteTransp
ortAtReactor.csv, listed in an 
installation’s Reports list, in the 
Table of Contents. 
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44 Allocation 
At Reactor 

CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

Custom report: Shows the 
allocation type for each cask. 
Can be generated for each 
installation or across all 
installations. 

To display:   Analyst can right-
click on allocationAtReactor.csv, 
listed in an installation’s Reports 
list, in the Table of Contents. 

45 Packed 
Assembly 
Zones 

CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

Custom report: Shows a table of 
packed assembly zones, zone slot 
number, and cask ID for each 
packed cask. Can be generated 
for each installation or across all 
installations. 

To display:   Analyst can right-
click on 
packedAssemblyZones.csv, listed 
in an installation's Reports list, in 
the Table of Contents. 

46 Allocation CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

Shows the current site allocation, 
cumulative allocation total, 
current site name, and current 
site index for planned allocation. 

To display:   Analyst can right-
click on allocation.csv, listed in a 
Planner installation’s Reports list, 
in the Table of Contents. 

47 Transportati
on Costs 

CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

Shows the traversal costs, miles, 
and days of each leg of each 
itinerary. 

To display:   Analyst can right-
click on transportationCost.csv, 
listed in a Transportation 
installation's Reports list, in the 
Table of Contents. 

48 Ad Hoc/ 
Custom 
Reports 

CSV file, 
displayed as a 
table 
(exportable to 
.xls) 

User-defined: Shows any 
available Attributes of any 
available Tasks (within a 
scenario). 

Custom reports that can be 
defined for any of a scenario's 
Tasks. To display:   Analyst can 
right-click on the defined report, 
listed in an installation's Reports 
list, in the Table of Contents. 

49 Transportati
on Costs -- 
Rail 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows various costs related to 
rail transportation. 

To display: Analyst can select the 
report from the Reports-
>Scenario Results Reports-
>Transportation menu 

50 Final Railcar 
Mileage by 
Railcar 

Table 
(exportable to 
.csv and .xls) 

Shows the miles traveled and 
number of trips by railcar.  

To display: Analyst can select the 
report from the Reports-
>Scenario Results Reports-
>Transportation menu 

51 Cumulative 
Railcar 
Mileage 

Graph/Table 
(exportable to 
.csv and .xls) 

Shows the cumulative loaded and 
unloaded miles by railcar.  

To display: Analyst can select the 
report from the Reports-
>Scenario Results Reports-
>Transportation menu 



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual 43 
 

 

52 Transportati
on Schedule 
- 
Unscheduled 
Casks 
 

 

Graph/Table 
(exportable to 
.csv and .xls) 

Displays unscheduled casks for 
all sites by year. 

To display: Analyst can select the 
report from the Reports-
>Scenario Results Reports-
>Transportation menu 

53 Transportati
on Schedule 
- 
Unscheduled 
Casks by 
Site 

Graph/Table 
(exportable to 
.csv and .xls) 

Displays unscheduled casks for 
each ISF by year. 

To display: Analyst can select the 
report from the Reports-
>Scenario Results Reports-
>Transportation menu 

54 Repackaging Table 
(exportable to 
.csv and .xls) 

Displays repackaging values by 
year/activity.  

To display: Analyst can select the 
report from the Reports->Calvin 
Reports menu 

55 Summary 
Info: Pools 

Table 
(exportable to 
.csv and .xls) 

Displays first and last shipment, 
discharge and dry storage dates 
for each pool.  

To display: Analyst can select the 
report from the Reports->Calvin 
Reports menu 

56 Summary 
Info: Reactor 
Units 

Table 
(exportable to 
.csv and .xls) 

Displays first and last discharge 
dates for each reactor. 

To display: Analyst can select the 
report from the Reports->Calvin 
Reports menu 

57 Summary 
Info: Sites 

Table 
(exportable to 
.csv and .xls) 

Summarizes activity at each site 
including: first and last discharge 
dates, first and last shipment 
dates from pool and dry storage, 
first and last shipments from site, 
first and last dry storage dates, 
years with fuel on site and the 
delay in years for pool shutdown.  

To display: Analyst can select the 
report from the Reports->Calvin 
Reports menu 
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Appendix B Transportation 
Overview 

The NGSAM transportation logic integrates the Java Transportation Operations Model (JTOM) into 
NGSAM.  The allocation logic of NGSAM generates input to JTOM consisting of requests that 
transportation be provided to transport the SNF that has been allocated.  After JTOM has been run, 
NGSAM uses the output from JTOM to control the formation and scheduling of trains within the 
simulation. 
 
Transportation in the simulation is modeled using the concept of an itinerary that consists of one or more 
legs.  A leg represents travel from one physical location to another physical location.  For example, 
traveling from a reactor to an intermediate storage facility (ISF) is one leg of travel.  Travel from a railcar 
maintenance facility to a reactor is another leg of travel.  An itinerary is a list of legs that transportation 
assets must execute in sequence, allowing for some processing time at each facility that is visited along 
the itinerary.  Most itineraries are organized around some objective of SNF transportation.  For example, 
in order to achieve the objective of picking up SNF from a reactor and bringing it to an ISF, a train might 
travel empty from the railcar maintenance facility to the reactor (the first leg), pick up the SNF at the 
reactor (processing after the first leg), travel loaded from the reactor to the ISF (the second leg), drop off 
the SNF at the reactor (processing after the second leg), travel empty back to the railcar maintenance 
facility (the third leg), and undergo railcar maintenance (processing after the third leg).  Since JTOM 
models train travel as trips originating at and returning to the railcar maintenance facility, itineraries 
typically have two or three legs, depending on whether the railcar maintenance facility is co-located with 
the ISF. 
 

 
An itinerary in NGSAM is responsible for managing its legs and for obtaining transportation assets.  For 
instance, an itinerary for a three-cask-railcar train has the responsibility of obtaining three cask railcars 
and assembling them into a train.  NGSAM does not explicitly model the movement of escort and buffer 
cars.  The escort cars and buffer cars are passed to JTOM, and accounted for in the scheduling, but in the 
NGSAM model itself it is implicit that each assembled train includes the escort and buffer cars that it 
needs.  After obtaining and assembling transportation assets, the itinerary manages handing off control of 
the transportation asset group to each leg in turn until all legs of travel are completed. 
 
Itinerary legs are responsible for receiving a transportation asset group, such as a train, when it is handed 
off from an itinerary.  After receiving the handoff, the leg is responsible for communicating with the asset 
group and sending the asset group from the leg’s origin – which should be the current location of the asset 
group – to the leg’s destination.  When the transportation asset group has completed whatever processing 

Maintenance 
Facility 

Intermediate 
Storage 

Facility (ISF) 

Reactor 

Leg 1 

Leg 2 

Leg 3 

Figure 46 A typical Itinerary 
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is necessary at the leg’s destination, the itinerary itself regains control of the transportation assets and 
manages handing them off to the next leg, if any, or disassembles the transportation asset group into 
individual transportation assets if there are no more legs. 
 
Scheduling (JTOM Integration) 

The transportation scheduling logic appears in the Transportation installation under Plans->Scheduling.  
Transportation scheduling is initiated at the beginning of a simulation by a JTOMInitializer entity that is 
generated using a generator in the Transportation installation.  The JTOMInitializer resets JTOM, 
preparing it for use in the current scenario.  The task responsible for this is in the Init JTOM course of 
action in the Scheduling plan.  It calls the Java method TransportationManager#reset. 
 
Each transportation scheduling period, a round of transportation scheduling is initiated by a 
TransportationInit agent sent from the allocation process in the planner.  This agent completes the tasks in 
the Initialization course of action in the Scheduling plan, calling the Java method 
TransportationManager#initialize and creating TransportationRequestProcessingSlot resources to pave 
the way for transportation requests from specific reactor sites. 
 
Each reactor site as well as, in some cases, the monitored geologic repository (MGR) sends a 
TransportationRequest agent to the Transportation installation.  These requests are handled by the 
Request Reception course of action in the Scheduling plan.  Each request is recorded as input to JTOM by 
calling the Java method TransportationManager#addTransportationRequest.  Each request that is recorded 
uses up a TransportationRequestProcessingSlot.  When the resources run out, the Schedule Transportation 
task adds the last transportation request of the transportation scheduling period to JTOM and calls the 
Java method TransportationManager#executeForPeriod.  This Java method tells JTOM to find a 
transportation solution for the current period that fulfills transportation requests that were added in the 
scheduling period.  Then it reads the trips that JTOM chooses and converts them into Itinerary and Leg 
agents, scheduling those agents to appear in the transportation installation at the proper time. 
 
Railcars and Trains 

The number of cask cars, buffer cars, and escort cars in a scenario is defined as input in the unf-
vehicles.csv file in the scenario input directory.  The NGSAM GUI launches Excel to edit this file when 
the user clicks on Edit->Vehicles.  In the scenario logic, the first time that the Java method 
TransportationManager#initialize is called, the unf-vehicles.csv file is read, and a VehicleGenerator agent 
is created that will execute the GenerateVehicles course of action in the VehicleGeneration plan.  This 
plan creates Railcar agents that represent empty cask cars. 
 
When cask cars are created and initialized, they become individual empty railcars that are available to 
become part of a train and complete an itinerary.  A cask car in this state is an AvailableRailcar resource 
in the simulation.  An itinerary that requires a train will acquire enough AvailableRailcar resources to 
form the train that it needs and will direct those railcars to become a train.  After a train has completed an 
itinerary, the itinerary directs to train to disassemble itself.  After the train has disassembled the cask cars 
once again become AvailableRailcar resources. 
 
When a train is assembled in the NGSAM model, it does not know which installation it should go to.  In 
order to communicate with a leg of the itinerary and receive direction on where to go, the train becomes 
an AssignableTransportation resource.  The first leg of the itinerary uses the AssignableTransportation 
resource and tells the newly assembled train where it should go and all of the other trip details, such as the 
costs of the transportation.  Each time that the train completes a leg and the processing at the destination 
of the leg, it returns to the Transportation installation and again becomes an AssignableTransportation 
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resource.  As long as there is another leg in the itinerary, the next leg will update the train’s transportation 
details, including telling it what the next destination is.  After the last leg of the itinerary is complete, the 
itinerary itself will communicate with the train and instruct it to disassemble. 
 
To run JTOM in acquisition mode (i.e. the simulation only buys the number of railcars it needs), edit the 
unf-vehicles.csv file from the Edit->Vehicles menu and set the numeric values to 0 and unconstrained to 
true. 
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Appendix C Allocation and Acceptance 
Overview 

NGSAM’s allocation and acceptance process, often referred to as merely the allocation process in this 
document, controls decisions about which waste packages will be shipped from which reactor sites to 
which ISFs. In NGSAM, the allocation process runs at the beginning of each simulation year. It is 
initiated in and managed in the scenario’s Planner installation but involves communication between 
installations. 

 
Figure 47 Allocation and Acceptance 

The allocation process distinguishes between the Integrated Waste Management Systems (IWMS) as a 
whole and sites with the IWMS. In the current version of NGSAM, the only type of IWMS site included 
in the allocation process is an interim storage facility (ISF), and there can be up to three ISFs. The 
allocation process can model three different types of constraints related to the IWMS and its sites: 
package type constraints, rate constraints, and capacity constraints. Package type constraints can limit 
which types of waste packages a site within the IWMS can receive. Rate constraints can limit the number 
of canisters that a site within the IWMS or the IWMS as a whole can receive during a simulation year. 
Capacity constraints can limit the number of waste packages that an IWMS site may have in its inventory. 
Users define the applicable constraints and can change the constraint that applies each simulation year. 

The allocation process had two components. The first component is an inventory component that can 
query the reactor sites to determine which assemblies have been discharged at the reactor site and remain 
in the inventory of the reactor site. The second component is an allocation negotiation component that 
queries the reactor sites to determine whether they can provide waste packages that satisfy various 
constraints. 

The current version of NGSAM supports only one allocation algorithm. At the core, that algorithm is an 
oldest fuel first (OFF) allocation algorithm. In this algorithm, oldest fuel means the oldest assembly, that 
is, the assembly that was discharged from its reactor longest ago. Using the inventory component to 
determine which assemblies are discharged each year, the algorithm keeps a record of which assemblies 
would be in the inventory of each reactor site if the site had sent its oldest assemblies each time that it 
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shipped a package. This record, called the OFF assumed inventory, rarely agrees with the actual 
inventory; however, the algorithm uses the record to determine the oldest remaining assembly that each 
site would have on hand if all sites had been shipping their oldest assemblies each time they sent a 
shipment. Unless a user-specified site allocation overrides it, the algorithm gives the highest priority for 
allocating a waste package to the site that would have the oldest assembly according to the OFF assumed 
inventory. 

The allocation algorithm uses the allocation negotiation component to negotiate with one reactor site at a 
time, determining whether that reactor site can provide a waste package that satisfies the current package 
type, rate, and capacity constraints. If the queried reactor site can provide a package, the allocation 
algorithm will choose which IWMS site will receive that package. Then it will update the constraints for 
that site and for the IWMS as a whole, reducing the remaining number of canisters that can be received 
and, if the site has reached its capacity or rate limit, updating the types of packages that the system is 
capable of receiving. If the queried reactor site cannot provide a waste package that satisfies current 
constraints, the allocation algorithm moves to the reactor site with the next highest priority and negotiates 
with that reactor site to determine whether that reactor site can provide a waste package that satisfies the 
constraints. This process continues until the system cannot receive any more packages or until no reactor 
site can provide a package that satisfies the package type constraints of the IWMS sites that have 
remaining rate and capacity. 

In cases where the user has specified which reactor sites the allocation algorithm should use, the 
allocation algorithm negotiates with reactor sites in the order that the user has specified for the number of 
packages that the user has specified, skipping over sites when those sites cannot provide any more waste 
packages that satisfies the current constraints. The algorithm continues to maintain the OFF assumed 
inventory while negotiating the user-specified site allocation. If there is capacity remaining after user-
specified site allocation has been completed, the algorithm will continue to allocate waste packages if 
possible, giving priority to sites according to the age of the oldest assembly that would remain at each 
reactor site according to the OFF assumed inventory. 

Constraint Definition and Interpretation 

The user-defined package type constraints, rate constraints, and capacity constraints are stored in a file 
named constraints.csv in the scenario directory. Users can access the file with the Edit->Allocation 
Constraints menu item. Users may also navigate to this file in the file system and edit it directly. 

 
Figure 48 Example Constraints file as accessed via the Edit->Allocation Constraints Menu 

 
The file contains five columns, named Year, Site, ConstraintCategory, ConstraintType, and 
ConstraintValue. 
 
The “Year” column defines which year the constraint will take effect or change from its previous value, 
and the “Site” column defines which IWMS site the constraint applies to. Currently, valid values for the 
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“Site” column are “ISF 2”, “ISF 3”, “Eastern ISF”, and “System”. A value of “System” indicates that the 
constraint applies to the IWMS as a whole. 
The “ConstraintCategory” column defines which category of constraint is defined in the remaining 
columns. Valid values are “PkgType”, indicating a package type constraint, “Rate”, indicating a rate 
constraint, and “Capacity”, indicating a capacity constraint. At the level of the IWMS as a whole, the only 
valid constraint category is “Rate”. 
 
For rate constraints and capacity constraints, the value in the “ConstraintType” column must be either 
“U”, which means unconstrained, or “C”, which stands for constrained. If the value is “U”, then any entry 
in the “ConstraintValue” column is ignored, and the capacity will be unconstrained. If the value is “C”, 
then the “ConstraintValue” must contain an integer, which will be interpreted as a number of canisters. 
If the capacity at an IWMS site is constrained, the allocation process will check the inventory of that site 
at the beginning of the year, and the number of canisters sent to the site that year will not exceed the 
difference between the defined capacity constraint and its current inventory. This is enforced even if the 
IWMS site is planning to decrease its inventory during the year by sending waste packages to other 
IWMS sites. Although the capacity constraint at an IWMS site can change between years, the current 
implementation does not support decreasing the constraint. If the constraints input file defines a row that 
would decrease the capacity or make it a constrained capacity after it was previously set to unconstrained, 
that row of the constraints input file will be ignored. 
 
If the capacity at a IWMS site or for the IWMS system as a whole is constrained, the allocation process 
will ensure that the number of canisters shipped from any source to that site or, for the system constraint, 
from reactor sites to any IWMS site within the system, does not exceed the number of canisters defined in 
the rate constraint. 
 
For package type constraints, the value in the “ConstraintType” column must be either “L”, which stands 
for list, or “C” which stands for category. If the value is “C”, the “ConstraintValue” column must contain 
a value that identifies a category of package types. The only category supported in the current NGSAM 
implementation is the category “All”, which is a convenient way to say that an IWMS site can accept any 
type of waste package. When the value in the “ConstraintType” column is “C”, the “ConstraintValue” 
column must contain a list of canister model identifiers – basically names of canister types – separated by 
the vertical bar “|”. 
 
For package type constraints that give a list of package types, the allocation process will ensure that all 
packages shipped to the site where the constraint applies will be waste packages that have a canister 
model that matches one of the values in the list. 
 
Constraints that are defined to apply in one year will apply to each subsequent year unless and until a year 
is reached where the user has defined a change to the constraint. 
 
Here is the sample content of a constraints.csv file. 

Year Site ConstraintCategory ConstraintType ConstraintValue 
2021 ISF 2 PkgType L MPC-24|MPC-24EEF|MPC-32 
2021 ISF 2 Rate C 10 
2021 ISF 2 Capacity C 300 
2021 ISF 3 PkgType L NUHOMS FC-DSC|NUHOMS FF-DSC 
2021 ISF 3 Rate C 10 
2021 ISF 3 Capacity C 400 
2021 System Rate C 40 
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2027 ISF 2 Rate C 30 
2027 ISF 2 Capacity C 600 
2027 ISF 3 Rate C 30 
2040 Eastern ISF PkgType C All 
2040 Eastern ISF Rate C 10 
2040 Eastern ISF Capacity U 

 

 
This sample input does not make much sense for use in an actual scenario, but it does illustrate most of 
the possible values that are supported in NGSAM. 
There may be some features of the CSV format that are not supported in the current implementation of 
NGSAM when reading a constraints file; however, editing the file in Excel, as is the default editor when 
launching the editor for the constraints from the NGSAM interface, should work fine as long as the proper 
format for the constraints is observed. NOTE: Care should be taken when deleting lines in the file to 
ensure that the line is completely gone.  
 
IWMS Site Choice 

During the negotiation with a reactor site, the overview states that the allocation algorithm chooses which 
IWMS site will receive a package from a reactor site. This section gives a little more detail about how that 
IWMS site is chosen and what the user can do to influence that choice. 
 
The IWMS sites are organized into allocation priority tiers. In the current implementation, the priority 
tiers apply to only ISFs, and the priority tier of an ISF is defined by the isfAllocPriorityTier attribute of 
the ISFDbDataAgent generated at the ISF. Lower numbers indicate higher priority, so the default scenario 
settings, which give a value of 1 to ISF 2 and ISF 3 and a value of 2 to Eastern ISF mean that ISF 2 and 
ISF 3 will be preferred over the Eastern ISF. 
 
The negotiation process includes an allocation query for each allocation priority tier. If a package can be 
provided for a higher allocation priority tier, lower allocation priority tiers will not be attempted. Thus 
with the default scenario settings, the allocation algorithm will first ask a reactor site if it can provide a 
package that could be sent to either of ISF 2 or ISF 3. If that is impossible, then the allocation algorithm 
will follow up by asking whether the reactor site can provide a waste package that could be sent to 
Eastern ISF. If that is also impossible, then the negotiation is complete and the allocation will continue 
with the next reactor site, if any. 
 
When there are multiple IWMS sites within the same allocation priority tier, the allocation algorithm has 
more flexibility in choosing which site will receive a waste package. In the current implementation, the 
algorithm first checks the site constraints to determine which of the sites can actually receive the waste 
package according to package type constraints, site rate constraints, and site capacity constraints. If there 
are multiple such sites, the current implementation makes the choice in a style that approximates a round 
robin choice, selecting the IWMS site which has least recently been allocated a waste package. 
 
User-Defined Site Allocation 

The user-defined site allocation is stored in a file named AllocationPriority.xlsx in the scenario directory. 
Users can access the file with the Edit->Allocation Priority menu item. Users may also navigate to this 
file in the file system and edit it directly. 
 
The Excel workbook may contain multiple worksheets. The name of the worksheet indicates the year that 
the data from that worksheet will begin to apply. The data from that year will apply to any subsequent 
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years that do not have a worksheet in the Excel workbook. Each worksheet should have two columns 
named “Site” and “Site Allocation (Casks)”. 
 
The “Site” column defines a reactor site to which the allocation process should allocate packages. The 
“Site Allocation (Casks)” defines the number of canisters that the allocation process should allocate to 
that site at that point during the allocation process. The site name must be an exact match for the name of 
reactor site installation in the NGSAM scenario. The allocation process will work from the top of the 
worksheet down to the bottom of the worksheet. A site may appear in multiple rows in the spreadsheet; 
the allocation process will attempt to allocate to the site each time that it appears. 
 
If an analyst desires pure oldest fuel first allocation, the appropriate input, which is the default input for 
the USFleet scenario, is a workbook with a single spreadsheet that is blank except for the column headers. 
NGSAM writes out an allocation results file that matches the format of the allocation input file. This file, 
named AllocationResults.xlsx is written to the output directory that contains the other results of the 
NGSAM model run. Users can access it using the Reports->Scenario Results Reports->Allocation 
Results menu item. This file can be saved and tweaked to provide input to a subsequent model run and 
get similar but slightly different allocation. 
 

  



Next-Generation Waste Management System Analysis Model (NGSAM) Training Manual 52 
 

 

Appendix D Glossary 
• Acceptance – The stage at which spent nuclear fuel or high-level radioactive waste has been 

prepared for transportation by a waste generator and accepted for transportation in the waste 
management system. Traditionally, acceptance specifically implies a transfer of ownership from 
the generator to the disposing agency.  

• Acceptance Approach – The approach waste generators use (i.e., oldest fuel first [OFF] or 
youngest fuel first [YFF]) to prioritize acceptance of spent nuclear fuel or high-level radioactive 
waste into the waste management system.  

• ALARA (as low as reasonably achievable) – A radiation safety principle to minimize radiation 
doses by employing the methods of time, distance, or shielding. As defined in Title 10, Section 
20.1003, of the Code of Federal Regulations, implementing the ALARA principle means that 
every reasonable effort is being made to maintain exposures to ionizing radiation as far below the 
dose limits as practical. This practice is consistent with the purpose for which the licensed activity 
is undertaken, taking into account (1) the state of the technology being used, (2) the economics of 
improvements in relation to the state of technology, (3) the economics of improvements in 
relation to benefits to the public’s health and safety, (4) other societal and socioeconomic 
considerations, and (5) use of nuclear energy and licensed materials in accordance with the public 
interest.  

• Allocation – The amount of spent nuclear fuel or high-level radioactive waste that a waste 
generator is allotted to have received into the waste management system. Allocation determines 
(1) which waste generators ship spent nuclear fuel or high-level radioactive waste, and (2) how 
much material is to be shipped from each waste generator or custodian in a given year.  

• Allocation Priority – The approach used to define allocation. Allocation priority for commercial 
spent nuclear fuel is defined by the Standard Contract as oldest fuel first (OFF).  

• Argonne National Laboratory (ANL) – National laboratory and contributor to the Nuclear 
Fuels Storage and Transportation Planning Project located in Lemont, Illinois.  

• Assembly – see fuel assembly.  

• Bare Fuel Cask – see cask.  

• Boiling Water Reactor (BWR) – A light water moderated and cooled nuclear power reactor 
design in which water flows upward through the core, where it is heated by fission and allowed to 
boil in the reactor vessel. The resulting steam then drives turbines, which activate generators to 
produce electrical power. BWR assemblies are generally smaller (both in mass and number of 
rods) than pressurized water reactor assemblies.  

• Boiling Water Reactor (BWR) Assembly – A nuclear fuel assembly used in a boiling water 
reactor. (See fuel assembly.)  

• Bolted Closure – A method for closing and sealing a cask in which bolts are used to retain a lid; 
a metallic or elastomeric o-ring provides a seal between the body of the container and its lid. This 
type of closure is typically used on casks designed for reuse.  

• Buffer Car – A rail car used to separate other rail cars transporting spent nuclear fuel from 
positions on the train occupied by personnel.  

• Burnup – The degree to which the uranium in nuclear fuel has been consumed. Burnup is 
measured as the energy released by a spent nuclear fuel assembly divided by the mass of uranium 
initially loaded into the fuel assembly. Burnup is measured as either gigawatt-days per metric ton 
of initial uranium (GWd/MTU) or gigawatt-days per metric ton of initial heavy metal 
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(GWd/MTHM). The two measures are identical for spent nuclear fuel generated by the current 
fleet of US commercial nuclear reactors since they are all fueled solely by uranium rather than 
plutonium or other heavy metals.  

• Canister – A welded metal enclosure that typically holds multiple spent nuclear fuel assemblies. 
The canister contains a basket that provides a metal lattice to hold the assemblies in place. Unlike 
casks, canisters are typically placed inside overpacks to ensure the necessary shielding, 
containment, and physical protection for storage, transportation, and disposal functions. Canisters 
are licensed either for storage only or for storage and transportation. No canisters are currently 
licensed for storage, transportation, and disposal.  

• Cask – A thick-walled, bolted enclosure that holds multiple spent nuclear fuel assemblies that 
provides shielding and does not require the use of an overpack. The three primary types of casks 
are storage casks, transportation casks, and those licensed for both storage and transportation. No 
casks are currently licensed for storage, transportation, and disposal.  

• Cask Transporter – Heavy machinery that lifts and moves casks (or canisters in transfer 
overpacks) between storage pads, marshalling yards, fuel handling buildings, or spent fuel pool 
buildings. Vertical and horizontal variations exist for the different canister systems.  

• Centralized Used Fuel Resource for Information Exchange (CURIE) – Website that provides 
usable, collaborative document and data access, serving as a national resource for industry, 
vendor, federal, and laboratory partners.  

• Certificate of Compliance (CoC) – The document issued by the US Nuclear Regulatory 
Commission (NRC) indicating that an item meets all applicable regulations and can legally be 
used for its proposed purpose. The CoC for a cask contains technical requirements and operating 
conditions for a specific cask design, and it specifies what the licensee is authorized to store in the 
cask system.  

• Civilian Radioactive Waste Management System (CRWMS) Analysis and Logistics Visually 
Interactive (CALVIN) – Part of the Transportation-Storage Logistics (TSL) software that 
models packaging, storage and repackaging of spent nuclear fuel at all facilities. CALVIN 
establishes schedules for shipments between facilities that are entered into the Transportation 
Operations Model (TOM) software.  

• Consist – A collection of railroad assets used for transportation of spent nuclear fuel or high-level 
radioactive waste. A complete consist typically includes an engine/locomotives, buffer cars, cask 
cars (for holding SNF casks or canisters in overpacks), and an escort car.  

• Damaged Fuel Can – A thin-walled container for damaged fuel assemblies providing ventilated 
gross confinement of the fuel so that air, helium, or water can flow in and out. The can is only 
slightly larger than the fuel assembly to allow for handling, transportation, and storage similar to 
that for an undamaged assembly.  

• Disposal Overpack – An overpack used to contain a canister so that it meets the requirements of 
a specific geologic disposal concept. 

• Dry Storage – Storage of spent nuclear fuel outside the spent fuel pool (i.e., not in water), 
typically with spent nuclear fuel in a storage cask on a concrete pad or in a canister inside a 
storage overpack or horizontal storage module on a concrete pad. Several dry storage system 
concepts have been designed, including underground silos and above- or below-ground vaults. 
(See storage overpack and storage cask for more information.)  
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• Dual Purpose Canister (DPC) – A spent nuclear fuel canister that can be used for (1) storage 
inside a storage overpack, (2) transportation in a transportation overpack, or (3) dry storage 
loading operations with a transfer overpack.  

• Dual Purpose Cask – A cask that can be used for transportation and storage of spent nuclear 
fuel.  

• Escort Car – A car at the end of a convoy that is used for transporting personnel and equipment 
not involved with operating the train.  

• Execution Strategy Analysis (ESA) Tool – A tool used for ongoing performance assessment of 
the evolving project plan/strategy, accounting for significant assumptions, risks, and uncertainties 
throughout the project life cycle. The ESA tool models institutional and management decisions 
rather than physical systems.  

• Fiscal Year (FY) – A period ranging from October 1 of the prior year to September 30 of the 
current year. (For example, FY16 is from October 1, 2015 through September 30, 2016.)  

• Fuel Assembly – A group of fuel rods, guide tubes, fuel rod spacers, and upper/lower end fittings 
for use in a nuclear reactor. The fuel rods in the assembly are bundled so that the entire collection 
can be moved as a single physical unit.  

• Fuel Cycle Research and Development (FCRD) Program – A program within the US 
Department of Energy’s Office of Nuclear Energy whose mission is to conduct research and 
development for sustainable fuel cycles as described in the Nuclear Energy Research and 
Development Roadmap.  

• Fuel Rod – A long slender metal tube (typically made of Zircaloy) containing uranium dioxide 
fuel pellets; fuel rods are grouped together as fuel assemblies.  

• Greater-than-class C Low-level Radioactive Waste (GTCC LLW or GTCC) – Waste in 
which the concentration of radionuclides exceeds the limits for class C low-level radioactive 
waste as established by the US Nuclear Regulatory Commission in 10 Code of Federal 
Regulations 61.55, “Waste Classification.”  

• High-burnup Fuel – Fuel with a burnup over the threshold of 45 GWd/MTHM as defined by the 
US Nuclear Regulatory Commission.  

• High-level Radioactive Waste (HLW) – Highly radioactive waste material produced as a 
byproduct of reactions occurring inside nuclear reactors; HLW takes on two forms: (1) spent 
(used) reactor fuel that has been accepted for disposal, or (2) waste materials remaining after 
spent fuel is reprocessed.  

• Horizontal Storage Module – A ventilated concrete structure used to store a canister in the 
horizontal orientation at an independent spent fuel storage installation or an interim storage 
facility.  

• Idaho National Laboratory (INL) – National laboratory and contributor to the Nuclear Fuels 
Storage and Transportation Planning Project located in Idaho Falls, Idaho. 

• Impact Limiter – A device made of energy-absorbing material (e.g., wood, foam, aluminum 
honeycomb) that reduces the acceleration of a transportation package during the impact of an 
accident. For some transportation packages, impact limiters provide thermal protection.  

• Independent Spent Fuel Storage Installation (ISFSI) – A facility designed and constructed by 
a reactor site operator for the interim storage of spent nuclear fuel, solid reactor–related greater-
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than-class-C waste, and other radioactive materials associated with spent nuclear fuel and reactor-
related greater-than-class-C waste storage.  

• Interim Storage Facility (ISF) – A centrally located facility, most likely away from a reactor’s 
independent spent fuel storage installation, for temporarily storage of spent nuclear fuel from 
across the US reactor fleet. Spent nuclear fuel assemblies can be shipped from reactor sites to an 
ISF, stored, and ultimately shipped to a repository for final disposal.  

• Low-level Radioactive Waste (LLW) – Nuclear waste that is not intermediate-level waste, high-
level waste, spent nuclear fuel, or transuranic waste.  

• Metric Ton of Heavy Metal (MTHM) – Unit of measure commonly used for the mass of spent 
nuclear fuel. (Note that a metric ton is 1,000 kilograms.)  

• Metric Ton of Uranium (MTU) – Unit of measure commonly used for the mass of spent nuclear 
fuel. MTU is identical to metric ton of heavy metal for spent nuclear fuel generated by the current 
fleet of US commercial nuclear reactors since they are all fueled solely by uranium rather than 
plutonium or other heavy metals.  

• Mined Geological Repository (MGR) – Location for final disposal of spent nuclear fuel and/or 
high-level radioactive waste. An MGR facility combines the waste form, waste package, 
engineered seals, and natural barriers to provide a high-level of long-term isolation and 
containment for spent nuclear fuel and/or high-level radioactive waste.  

• Next-Generation System Analysis Model (NGSAM) – An advanced, agent-based system-level 
tool being developed to replace the Transportation-Storage Logistics (TSL) tool. NGSAM will be 
able to simulate scenarios for managing SNF, and it will support evaluation of several back-end 
SNF management scenarios for at-reactor storage, storage at an interim storage facility, and 
ultimate disposal using concepts specific to different geologic settings.  

• Integrated Waste Management (IWM) – formerly known as Nuclear Fuels Storage and 
Transportation Planning Project (NFST) – An organization within the US Department of 
Energy Office of Nuclear Energy that is working to identify, plan, and conduct the activities 
required to achieve the Administration’s Strategy milestones for interim storage and supporting 
transportation.  

• Nuclear Waste Policy Act (NWPA) – A US Federal law that established a comprehensive 
national program for the safe, permanent disposal of high-level radioactive waste and spent 
nuclear fuel.  

• Oak Ridge National Laboratory (ORNL) – National laboratory and contributor to the Nuclear 
Fuels Storage and Transportation Planning Project located in Oak Ridge, Tennessee.  

• Oldest Fuel First (OFF):  

1. A commercial spent nuclear fuel priority approach in which the allocation queue is established 
based the oldest spent fuel discharged from a nuclear reactor having highest priority.  

 
2. A commercial spent fuel acceptance approach where the oldest spent fuel residing at a reactor 

has the highest priority to be received by the waste management system.  
• Overpack – A thick container for canisters holding spent nuclear fuel. The overpack provides 

additional shielding and confinement to the canister. Each overpack is specific to the type of 
canister and its purpose (storage, transportation, or transfer).  

• Packaging:  
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1. The process of loading a canister or cask with spent nuclear fuel assemblies from a spent fuel 
pool or a bare fuel cask (see repackaging for further information).  

2. The container in which radioactive material is to be placed for transportation.  
• Pressurized Water Reactor (PWR) – A light water moderated and cooled nuclear power reactor 

design in which very pure water is heated to a very high temperature by fission and kept under 
high pressure to prevent boiling. The water is then used to make to steam from another stream of 
water inside a steam generator. The resulting steam is used to drive turbines which activate 
generators to produce electrical power. PWR assemblies are generally larger (both in mass and 
number of rods) than boiling water reactor (BWR) assemblies. 

• Pressurized Water Reactor (PWR) Assembly – A nuclear fuel assembly used in a pressurized 
water reactor. (See fuel assembly.). 

• Receipt – The receiving of spent nuclear fuel at an interim storage facility or a repository.  

• Repackaging – Loading a canister or cask with spent nuclear fuel assemblies after cutting open a 
welded canister.  

• Sandia National Laboratory (SNL) – National laboratory and contributor to the Nuclear Fuels 
Storage and Transportation Planning Project located in Albuquerque, New Mexico.  

• Savannah River National Laboratory (SRNL) – National laboratory and contributor to the 
Nuclear Fuels Storage and Transportation Planning Project located in Savannah River, South 
Carolina.  

• Site-specific Allocation (SSA) – Alternative allocation priority strategies for commercial spent 
nuclear fuel that are based on a reactor’s site conditions rather than the age of the spent nuclear 
fuel.  

• Spent Fuel Pool (SFP) – Storage pools for spent nuclear fuel from nuclear reactors. SFPs are 
robust constructions made of reinforced concrete several feet thick with steel liners, and the water 
is typically about 40 feet deep and serves to shield the radiation and cool the spent nuclear fuel.  

• Spent Nuclear Fuel (SNF) – Nuclear fuel (including fuel rods and fuel assemblies) that has been 
irradiated in a nuclear reactor.  

• Stack-up – The process of transferring a canister into a vertical storage overpack by stacking a 
transfer overpack on a vertical storage overpack with a mating adapter in between. The mating 
adapter is used to remove the bottom lid of the transfer overpack, and the canister is transferred 
between the two overpacks.  

• Stakeholder Tool for Assessing Radioactive Transportation (START) – A web-based 
decision support tool developed by the US Department of Energy as part of the Nuclear Fuels 
Storage and Transportation Planning Project for the purpose of evaluating routing options 
associated with the transportation of radioactive shipments.  

• Standard Contract – A contractual agreement between the US Department of Energy and the 
utility operators of the reactor fleet that specifies the obligations and liabilities for the 
management of spent nuclear fuel and high-level radioactive waste under the Nuclear Waste 
Policy Act.  

• Standardized Canister – A canister restricted to a standard set of designs that can be used for 
transportation, storage, and disposal when used in conjunction with the appropriate overpacks. 
(See triple purpose canister.)  
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• Storage and Transportation Canister – A canister licensed for both storage and transportation. 
(See canister.)  

• Storage and Transportation Cask (Dual Purpose Cask) – A cask licensed for both storage and 
transportation. (See cask.)  

• Storage Canister – A canister used specifically for storage of spent nuclear fuel. (See canister.)  

• Storage Cask – A cask used specifically for storage of SNF. (See cask.)  

• Storage Overpack – An overpack used for the storage of a spent nuclear fuel canister that 
provides shielding for the canister and ventilation to allow for cooling the fuel in the canister. 
Vertical storage systems and horizontal storage modules are the most prevalent storage overpack 
systems. Vertical storage systems store canisters upright so that they are taller and have a smaller 
footprint. Horizontal storage modules store canisters on their side so that they are shorter and 
have a larger footprint. Storage overpacks are typically reinforced concrete structures.  

• Storage Package – A storage cask or canister in a storage overpack a container (separable or not) 
that holds spent nuclear fuel, provides shielding and containment, and allows for the cooling of 
the spent nuclear fuel in a dry storage configuration.  

• Thermal Limit – Thermal limit refers to the regulatory thermal load limit allowed by a specific 
canister system design. Typically, there are separate limits for storage and transportation.  

• Transfer Cask – A bolted-lid metal cask with lifting trunnions to provide for engagement with 
other components (cask transporter or handling crane lift yoke) used to provide temporary 
shielding and structural protection for a spent nuclear fuel canister during fuel loading into an 
spent fuel pool and during transfer of the loaded canister to or from the storage overpack or 
transport cask. (See cask.)  

• Transfer Overpack – An overpack used to load and then transfer a canister from the spent fuel 
pool to dry storage. The transfer overpack provides shielding to reduce worker doses to levels that 
are as low as reasonably achievable (ALARA).  

• Transportation Cask – A cask with bolted closures that is used specifically for transportation of 
spent nuclear fuel and that is typically designed for reuse. (See cask for more information.)  

• Transportation Operations Model (TOM) – A component of the Transportation, Storage, and 
Logistics tool which assists the analyst in planning and evaluating scenarios for the transportation 
and storage of spent nuclear fuel. TOM provides detailed modeling of the transportation of spent 
nuclear fuel and the assets needed for transportation.  

• Transportation Overpack – An overpack used for the transportation of a spent nuclear fuel 
canister. The transportation overpack provides shielding and containment of the fuel. The canister 
and its overpack are typically transported horizontally. Impact limiters are added to the ends of 
the overpack prior to transportation in order to protect the overpack, the canister, and the fuel in 
case of a transportation impact incident or drop of the container assembly.  

• Transportation Package – The SNF and its packaging for the purpose of transportation: 
typically, a transportation cask with SNF or a canister with SNF in a transportation overpack, and 
the associated impact limiters. Effectively, it is the SNF and the container that holds SNF and 
provides shielding, containment, and physical protection of SNF throughout the transportation 
process.  

• Transportation-Storage Logistics (TSL) – A system-level software tool for simulating 
scenarios for managing spent nuclear fuel and a range of back-end SNF management scenario 
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involving at-reactor storage, storage at an interim storage facility, and ultimate disposal using 
concepts specific to different geologic settings.  

• Triple Purpose Canister – A canister that can be used to store, transport, and dispose of SNF. 
These canisters can store SNF when placed in a storage overpack. They can be used to transport 
SNF when placed in a transportation overpack. Finally, they can be used to dispose of spent 
nuclear fuel when placed in a waste package for emplacement in a repository. A Standardized 
transportation, aging, and disposal (STAD) canister is a standardized version of a triple purpose 
canister.  

• Trunnion – An apparatus typically consisting of cylindrically shaped projections on a package 
that are attached by various means and used to lift, tie down, support, or tilt packages from 
horizontal and vertical modes.  

• Unified Database – A controlled, unified domestic spent nuclear fuel system database integrated 
with nuclear analysis capabilities to support DOE waste management and fuel cycle-related 
objectives. It is contained in the UNF-ST&DARDS tool.  

• US Department of Energy Office of Nuclear Energy (DOE-NE) – An organization whose 
primary mission is to advance nuclear power as a resource capable of meeting US energy, 
environmental, and national security needs by resolving technical, cost, safety, proliferation 
resistance, and security barriers through research, development, and demonstration.  

• Used Nuclear Fuel (UNF) – Nuclear fuel (including fuel rods and fuel assemblies) that has been 
irradiated in a nuclear reactor. Synonymous with spent nuclear fuel.  

• Used Nuclear Fuel–Storage, Transportation & Disposal Analysis Resource and Data System 
(UNF-ST&DARDS) – A database and associated analytical tools being developed as a 
foundational resource for DOE’s Office of Nuclear Energy to streamline computational analysis 
capabilities for characterizing the input for the overall waste management system.  

• Vacuum Drying – A process to remove the remaining water inside a canister or cask prior to dry 
storage or transportation by drawing a vacuum, causing the water inside the canister or cask to 
vaporize and be removed.  

• Vertical Storage Systems – A ventilated concrete structure used to store a canister in the vertical 
orientation at an independent spent fuel storage installation or an interim storage facility.  

• Waste Package – A combination of (1) packaging components used for disposal of spent nuclear 
fuel, and (2) the fuel itself. 

• Welded Closure – A method for closing and sealing a spent nuclear fuel canister in which the 
weld is used around the lid of the container to create a seal. Redundant welds are typically used to 
ensure containment. This type of closure is commonly used on canisters and makes retrieval of 
the spent nuclear fuel more difficult than when bolted closure is used. Retrieving fuel from a 
welded canister involves cutting the canister open, usually rendering the canister unusable.  

• Youngest Fuel First (YFF):  

1. An alternative commercial spent nuclear fuel allocation priority approach in which the 
allocation queue is established based the youngest spent fuel discharged from a nuclear 
reactor having the highest priority.  

2. A commercial spent fuel acceptance approach in which the youngest spent fuel residing at a 
reactor has the highest priority to be received by the waste management system.  
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• Youngest Fuel First-5 (YFF-5) – Youngest fuel first, with a minimum spent nuclear fuel cooling 
time of five years out of the reactor. 
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Appendix E Installation Instructions 
 

The NGSAM installer is fairly self-explanatory. Double click on NGSAM-PAT_x64_V2.0-
win64_Installer.exe, and the image below appears if you have administrator privileges on the machine 
you are installing.  

 
 

Click on the ‘Next’ button. Either change the installation location or keep the default location and click on 
the ‘Next’ button. 
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Click on the Install button to start the installation. 

 
 

The installation complete dialog is displayed upon successful installation. Close the dialog box and you 
can find the ‘NGSAM-PAT_x64’ application in your programs. 
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Appendix F Web Interface for Client/Server 
NGSAM Status page 

The NGSAM Status page displays the status of the NGSAM cluster.  The status can be accessed, from the 
Argonne network via the following URL: https://ngsamsrv0.gss.anl.gov/#status  
 
The first table is the currently running simulations.  The table lists the server for the simulation, the slot 
on the server, the user, and the scenario.  The table also lists time statistics for the scenario, the current 
time of the simulation, the time the scenario was submitted to the cluster, the time the scenario started 
executing and the time the scenario finished running. 
 
The Queue table shows the scenarios that are pending.  The scenarios have been submitted but are waiting 
for node availability. 
 
The History table shows the last 48 scenarios from each simulation node.  The entries are copies of the 
status table once the scenario finishes. 
 

 
Figure 49 NGSAM Status Page 

 
  

https://ngsamsrv0.gss.anl.gov/#status
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NGSAM Scenario Page 

The NGSAM Scenario page displays a list of all scenarios in the user directory. It is located at the 
following URL: https://ngsamsrv0.gss.anl.gov/#scenarios .  The listing includes information for the 
scenario name, the output time, and the size the scenario is using on the server.  The Scenario page 
allows the user to perform for multiple actions for a given scenario.   
 
The first action is the Archive action.  This will compress the scenario and move it to the user’s /.archive 
directory in their home folder.  Please archive old runs that are no longer needed. 
 
The second action is the Calvin Reports.  Clicking the download icon for the Calvin Reports will 
download a zip file containing the contents of the calvinOutput directory. 
 
The third action is the Custom Reports.  The dropdown box under Custom has a list of the custom 
reports available in the output directory.  Selecting a specific report will download a zip file containing 
the selected report.  Selecting All will download a zip file containing all Custom Reports in the output 
directory. 
 
The Save and Browse actions are not implemented at this time. 

 

 
Figure 50 NGSAM Scenario Page 

https://ngsamsrv0.gss.anl.gov/#scenarios
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NGSAM Login form.   

The login form is found at: https://ngsamsrv0.gss.anl.gov/#login Use your NGSAM Username and 
password to log into the website. 
 
The website has a session timer of 10 minutes.  After being inactive for 10 minutes, the server will expire 
your session and require you to log in again to view any server information. 
 

 
Figure 51 NGSAM Login Form 

 
 
Once logged in, you will be able to see your session key through the profile menu.  The session key can 
be used by scripting to perform actions in batch.  Use the session key as the value of the HTTP Header 
Authorization when making batch requests to the server. 
 

 
Figure 52 Profile Menu 

 
 

 
 
  

https://ngsamsrv0.gss.anl.gov/#login
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Appendix G Continuous Integration 
 
NGSAM currently utilizes a Continuous Integration (CI) framework, called Jenkins, to automate and 
modularize the build process of NGSAM Client / Server software.  This has many benefits to end users of 
the NGSAM software, as it allows them to receive releases and new builds of the NGSAM client with a 
quick turnaround.  This also allows developers to distribute new releases of the NGSAM client (including 
bug fixes after a major release) with the click of a button. 
 
This guide will cover how end users can download releases of the NGSAM Client software distributed 
from the CI platform. 
 
 
 
Accessing NGSAM CI Release Website 

 
Releases of the NGSAM software can be found on the NGSAM CI webpage.  To go there, follow these 
steps: 
 

1) Using the Cisco AnyConnect VPN client, connect to vpn.anl.gov.  If you do not have a VPN 
account with ANL, please contact Brian Craig or Brent Kolasinski. 

 

2) In a web browser, go to http://ngsamci.gss.anl.gov.  You will see a webpage like the following: 
 

 
Figure 53 NGSAM CI Release Page 

 
 
 
  

http://ngsamci.gss.anl.gov/
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Downloading the Current Major Stable NGSAM Release 

 
This section details the steps needed to follow for downloading the current major stable release of the 
NGSAM client software.  The major stable release is what is recommended for analysts to be running. 
 

1) Follow the steps in section I to access the NGSAM release webpage. 
 

2) Under the “Stable NGSAM Client Releases” section, click a link that corresponds to your system 
type, Windows or Mac: 

 

 
Figure 54 NGSAM Release Versions 
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Downloading the Latest NGSAM Build 

 

The latest release of the NGSAM software is always accessible from a link on the NGSAM release 
website.  Usually this link will point to the current nightly build, which takes place at 0200 UTC every 
night.  However, a developer may also initiate a build of the NGSAM software ahead of the nightly build.  
In that case, the latest release link will point to the newest build. The timestamp at the top of the page 
gives information on when the last successful build of the NGSAM client was. 

 

This latest release link will always point to newest build of the NGSAM software, regardless of whether 
the build was initiated automatically by the scheduled nightly build, or manually by a developer. 

 

NGSAM end users should only be using the nightly builds under direction of an NGSAM developer or 
for testing new features or bug fixes in the client. 

 

To download the latest build: 

 

1) Follow the steps in section I to access the NGSAM release webpage. 
 

2) Click the “Latest Build:” link near the top of the page.  Note: The latest builds are built for 
Windows only.  These will not run on Mac or Linux systems.  If a Mac or Linux build is 
needed, please contact the NGSAM development team. 

 

 
Figure 55 Link to Latest NGSAM Build 
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3) To run the software, extract the zip file, and double click the “runPAT.bat” file. 
 
 
Accessing archived builds NGSAM releases 

 
If an end user of the NGSAM software needs to access an older build of the NGSAM software, they will 
need to go into the NGSAM Archive on the NGSAM Release Server.  Note that this will only need to be 
done under the direction of an NGSAM developer, for purposes of bug fixes or feature debugging. 
 

1) Follow the steps in section I to access the NGSAM release webpage. 
 

2) Click the “Archived Builds” link. 
 

 
Figure 56 Link to Archived NGSAM Builds 
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3) A new page will open, with the last 30 days of archived builds.  These are listed by date.  When 
downloading a specific release from a date, attention should be made to look at the file name.  To 
download, click the link for the release you want to download.

 
Figure 57 Links to Archived NGSAM Builds 

 
4) To run the archived build, extract the zip file that is downloaded, and double click on the 

“runPAT.bat” file. 
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Appendix H Quick Edit 
 

 
Figure 58  Launching NGSAM 

In this appendix, the Quick Edit mode will be demonstrated. To learn more about the Expert Edit mode, 
please see Appendix I for an in-depth tutorial exercise and example. Pressing on the Quick Edit button 
will bring up a dialog box to select a scenario (Figure 2). Select a scenario that has a quick edit 
configuration and click on the Open button.  

 
JTOM Configuration 
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Figure 59 JTOM Configuration Options 

• Max. Consist Size -  the maximum number of casks that can be picked up at the site at once 

• Number of Concurrent Handlings -  the number of consists that can be simultaneously loaded or 
unloaded 

• Operating Hours - hours available per day for loading and unloading operations 

 
MGR Configuration 

 
Figure 60 MGR Options 

• Max Packages Accepted Per Year – The maximum number of packages the storage facility can 
accept each year.  

 
Planner Configuration 

 
Figure 61 Planner Options 

• Allocation Algorithm – Algorithm used by the planner to allocate resources.  

 
ISF Configuration 
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Figure 62 ISF Configuration Options 

• Accept packages from reactor types – Types of reactors the interim facility can accept packages 
from.  

• Acceptance algorithm – Algorithm for how the interim facility accepts packages. 

• Allocation Proposal Algorithm – Algorithm for proposing allocation to the interim facility. 

 
Reactor Configuration 

 
Figure 63 Reactor Configuration Options 

• Allocation Proposal Algorithm – The algorithm used for proposing the allocation of resource.  

• Time after final discharge that the pool shuts down (years) – The number of years after which 
the pool can shut down.  

• Acceptance algorithm – The algorithm used for accepting packages.  

• Days before the Pre-Discharge Shutdown to begin packing to Dry Storage – Time at which 
packing to dry storage can occur.  
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Appendix I Training Exercises 
The following tutorials are intended as an example of how to use the functionality of the interface. They 
have been made generic to fit with any scenario. You will want to make a separate copy of any scenario 
used for the purposes of this tutorial. Assume any directions to open a node in the navigation tree refers to 
the first installation unless otherwise stated.  
Note that the changes that will be made may not produce accurate or desired results. These exercises are 
meant to show functionality and are not meant as a representation of how actual data should be used.  
Exercise 1: Looking at Results 

1. Open NGSAM 
2. Click on the “Expert Edit” button 
3. Choose one of the scenarios installed with the software and click Open.  This will load in the 

scenario.  
4. Do a File->Save As to save a copy of this scenario.  
5. In the navigation tree on the left, expand the Entity Types node and a note the sub-nodes there. 
6. Click on the Entity Types node. This will bring up a list of Entity types under the tree.  
7. Click on the one of the items to bring up more information on the entity in the center area.  
8. In the navigation tree on the left, expand the Resources node. Click on one of the nodes. This will 

bring up a table listing all resources.  
9. Note the values under the “Amount Available” column.  
10. Expand the Distribution node in the tree and note the items there.  
11. Click on one of the Distribution sub-nodes to see a table listing task distributions.  Note the type 

and attributes set for the distributions listed in the table.  
12. Click on the name of the installation node. This will change the context to show the start and end 

dates of the simulation.  Note that for any simulation time frame you must set end time. 
13. Expand the Plans node. This will bring up a sub tree in the bottom left. 
14. Click on one of the nodes in the sub tree.  
15. For the chosen record, double click on the Group cell and set it to “All”. 
16. In the sub-tree, expand the chosen node and click on the first Course of Action node listed.   
17. In the data area below the “Course of Action” diagram, click on the “Trigger Condition” tab. 
18. Set the trigger condition of the COA to “true” 
19. Note the tasks in the Course of Action diagram. Also note any arrows showing the flow between 

them.  
20. Click on one of the nodes.   
21. Select the Task tab in the lower area.  Set the values as follows:  Time interval is set to 1.0 second  
22. Click on another node.   
23. Select the Task tab in the lower area.  Set the values as follows:  Time interval is set to 3.0 days  
24. Below that table, click on the “Resources Required” tab. Add a resource if there is none using the 

“+” button. Set the values as follows:  Choose a resource from the dropdown seen when the cell is 
clicked. Amount is set to 0.01 and Disposition is set to “release” 

25. Click on a third node.   
26. Select the Task tab in the lower area.  Set the values as follows:  Time interval is set to 20.0 

minutes 
27. Below that table, click on the “Resources Required” tab. Note any Resources and add one if there 

isn’t one. Amount is set to 1 and Disposition is set to “consume” 
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28. Click on the “Attribute Set” tab.  Find a node with at least one attribute in table. Click on the 
“New Value” cell. 

29. Select “Text value” and set the value to something that makes sense for that particular attribute. 
Click the OK button. 

30. In the navigation tree on the left, click on the Generators node 
31. Choose a generator in the table that appears. Change the “Total Generated” value and the “Time 

Distribution” to something different. Set the “Units” to days. 
32. In the menu bar, click Simulation -> Validate. Note that there are no validation messages. 
33. If you did not do so at the beginning of the tutorial, perform a File-Save As and save this scenario 

in a new location.  
34. In the menu bar, click Simulation -> Save and Run  
35. Once the run finishes, look at results as follows: 

a. Expand the task node.  On each of the sub nodes, right click and choose the task name -> 
Results -> Graph All  

b. Expand the Resources node. For each of the sub-nodes, right click and select the resource 
name -> Graph Daily Resource usage.   

36. Click on the “Resources” node.   
37. Set the “Amount Available” for one of the resources used to 150.   
38. Set the “Amount Available” for another resource used to 0.5001. 
39. From the menu bar choose Simulation -> Save and Run.  
40. Once the run finishes, investigate the results as follows: 

a. In the navigation tree on the left, click on Plans and choose a Course of Action.  Note that 
in the Course of Action diagram, the circles have changed colors to reflect what 
happened during the simulation.  

b. Right click on one of the nodes and look at the various results. 
c. Close all of the open graphs and right click on the Resources-> <Resource used> node 

and select the <Resource used> -> Graph Cumulative Resource usage item. 
d. In the navigation tree on the left, right click on Plans-><Plan name> and select <Plan 

name> -> Agent Traversal for <Plan name>. 
e. In the pop up, choose an agent. Note the dates in the table that comes up.  

41. Note that the arrows in the course of action diagram do not control the flow. 
a. Expand the Entity Types node in the navigation tree on the left. Choose one of the listed 

Entity types. 
b. Click on the “Flow Attributes” tab.  Not the values there.  
c. Return to the Course of action diagram.  
d. Click on each task and choose the “Attributes Set” tab.  Note the values there.  
e. For each task, observe the trigger conditions on the “Trigger Conditions” tab.  

 
Exercise 2: Multiple Suppliers 

1. If it is not already open, File-> Open the demo item from Tutorial 1. 
2. Click on the Resources node in the navigation tree on the left.  
3. Reset the “Amount Available” for the resources that were changed in the first exercise to their 

original values.  
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4. In the Course of Action diagram, select the first node in the process and press the “Delete” key on 
your keyboard.  

5. A dialog asking to confirm the decision will appear. Confirm the delete.  
6. In the navigation tree on the left, click the “Tasks” node.  
7. In the lower table that appears, click the “+” button.  
8. In the “New name” box enter: Depart Node A and click the OK button. 
9. In the table, select the IT Depart Node A item.  
10. In the table that appears in the center, set the “Time Interval” to 1.0 and the “Time Units” to 

seconds. 
11. Return to the Tasks table in the lower left and click the “+” button. 
12. In the “New name” box enter: Depart Node B and click the OK button. 
13. In the table, select the IT Depart Node B item.  
14. In the table that appears in the center, set the “Time Interval” to 1.0 and the “Time Units” to 

seconds. 
15. In the Course of Action diagram, select “Create Step” from the top of the diagram.  
16. Click anywhere in the diagram. This will bring up the “Create Step” dialog 
17. From the “Use Existing Task” dropdown, choose “IT Depart Node A” and click “OK”. This will 

add the node to the diagram 
18. Once more, click anywhere in the diagram. This will bring up the “Create Step” dialog 
19. From the “Use Existing Task” dropdown, choose “IT Depart Node B” and click “OK”. This will 

add the node to the diagram. 
20. In the Course of Action diagram, select “Create Links” from the top of the diagram.  
21. Click on the “Depart Node A” node. 
22. Click on one of the previously existing nodes in the course of action window (If there is no node, 

create one with a new task). This will create an arrow linking the two.  
23. Click on the “Depart Node B” node. 
24. Click on the node from step 22. This will create an arrow linking the two.  
25. Above the Course of Action diagram, select the “Select and Move” option 
26. Click on the node from step 22 to bring up its table of information.  
27. Ensure that the “Trigger Condition” tab is selected.  
28. In the “Step Conditions” editor, select the “AND” node. 
29. Click on the “OR” button above the editor. This will add a new item to the tree.  
30. Drag the condition “Depart Node B completed = true” to the “OR” node. 
31. Drag the condition “Depart Node A completed = true” to the “OR” node. 

 
32. In the navigation tree on the left, click on the EntityType item 
33. Click the “+” button above the list of entity types. In the popup, enter “TestEntity” and click the 

OK button.  
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34. Select TestEntity and click the “+” button above the Attribute Table Editor to add a new attribute 
to the bottom of the table.   

35. Change the name of this new attribute to: manufacturer.  Leave the attribute a string attribute.  
36. In the navigation tree on the left, click on the Generators node 
37. Add a generator by clicking on the “+” above the Generator Table Editor table. Name this 

generator “TestEntityGenerator”.  
38. In the TestEntityGenerator row, set the type to “Agent” and the Entity to “TestEntity” 
39. In the TestEntityGenerator row, modify the row attributes by clicking on the right most cell in the 

table and then clicking on the “…” button that appears. 
40. In the dialog that pops up, click the “+” button.  
41. Click on the “Attribute” column and select manufacturer from the drop down.  
42. Enter “NodeA” as the “New Value” and click close.  
43. Set the “Total Generated” to 120. 
44. Above the Generator Table Editor, click the “+” button.  This will add another record to the 

bottom of the table.  
45. In this new record, set the “Type” to Agent.  
46. Set “Entity” to “TestEntity” and “Total Generated” to 80. 
47. Set the “Time Distribution” to one of the existing distributions or create a new distribution and 

the “Units” to days. 
48. Scroll to the right most column and click on the “Attributes” cell. And then click on the “…” 

button that appears in the cell.  
49.  In the dialog that pops up, click the “+” button.  
50. Click on the “Attribute” column and select manufacturer from the drop down.  
51. Enter NodeB as the “New Value” and click close.  
52. Return to the “Course of Action” diagram and click on the “Depart Node A” node 
53. In the Step Conditions Editor, click on the “Step Trigger” node in the tree.  
54. Above the Step Conditions Editor, click on the “+” button.  
55. In the dialog that pops up, ensure that the “Attribute Condition” item is the one selected.  
56. From the “Attribute” drop down, select “manufacturer” 
57. Leave the operator as “=” and enter “NodeA” as the value. Press the OK button. 
58. Expand the tree in the Step Conditions Editor to see the added condition.  
59. Return to the “Course of Action” diagram and click on the “Depart Node B” node 
60. Above the Step Conditions Editor, click on the “+” button.  
61. In the dialog that pops up, ensure that the “Attribute Condition” item is the one selected.  
62. From the “Attribute” drop down, select “manufacturer” 
63. Leave the operator as “=” and enter “NodeB” as the value. Press the OK button. 
64. Expand the tree in the Step Conditions Editor to see the added condition.  
65. In the menu bar, click Simulation -> Save and Run  
66. View the various tables and graphs for results. 

 

Exercise 3: Warehouse 

1. If it is not already open, File-> Open the demo item from Tutorial 2. 
2. In the navigation tree on the left, click on “Entity Types”.  
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3. In the lower table, make sure that the “Attributes” tab is selected.  
4. Click the “+” button to add a new attribute to the bottom of the table.  
5. Give that attribute the name “goToWarehouse” 
6. Set the “Type” of goToWarehouse to “Boolean”  
7. Set the “Default Value” of goToWarehouse to false. 
8. In the navigation tree on the left, click on “Resources” 
9. Click on the “+” button above the lower table.  This will pop up a creation dialog.  
10. In the dialog, enter “Warehouse Storage” for the name. and click “OK” 
11. For the new record, enter 20 as the Amount.  
12. Ensure that the values for Continuous and Constrained are checked.  
13. Click the “+” button above the table and add a resource called “Vehicle”. 
14. Set the amount available to 1 and ensure that the values for Continuous and Constrained are 

checked. 
15. In the navigation tree on the left, click on “Tasks” 
16. Click the “+” button above the lower left Tasks table.  
17. In the dialog that pops up, enter “Travel to Warehouse” as the name 
18. Select “Travel to Warehouse” from the table.  
19. In the central area’s upper Task Editor table, enter 2.5 as the “Time Interval” 
20. Set the “Time unit” to days 
21. Select the “Resources Required” tab for the lower table.   
22. Above the tale there, click the “+” button to create a record 
23. Set the “Resource” to be “Vehicle”, the “Amount” to be 0.01 and the “Disposition” to be 

“release”. 

 
24. Click the “+” button above the lower left Tasks table.  
25. In the dialog that pops up, enter “Store at Warehouse” as the name 
26. Select “Store at Warehouse” from the table.  
27. In the central area’s upper Task Editor table, enter 2 as the “Time Interval” 
28. Set the “Time unit” to days 
29. Above the “Resources Required” table, click the “+” button to create a record 
30. Set the “Resource” to be “warehouseStorage”, the “Amount” to be 1and the “Disposition” to be 

“release”. 
31. Click the “+” button above the lower left Tasks table.  
32. In the dialog that pops up, enter “Warehouse to Nodes” as the name 
33. Select “Warehouse to Nodes” from the table.  
34. In the central area’s upper Task Editor table, enter 0.5 as the “Time Interval” 
35. Set the “Time unit” to days 
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36. Above the “Resources Required” table, click the “+” button to create a record 
37. Set the “Resource” to be “vehicle”, the “Amount” to be 0.01 and the “Disposition” to be 

“release”. 
38. In the navigation tree on the left, click on “Distributions” 
39. Above the “Task Distribution Editor” table, click on the “+” button.  
40. In the dialog that pops up, enter EarlierManufacturing as the name. 
41. Set the type to “Uniform”.  
42. Set the Min value to 0 and the Max value to 5. 
43. Click the OK button. The record appears in the “Task Distribution Editor” table. 
44. Above the “Task Distribution Editor” table, click on the “+” button.  
45. In the dialog that pops up, enter LaterManufacturing as the name. 
46. Set the type to “Uniform”.  
47. Set the Min value to 5 and the Max value to 10. 
48. Click the OK button. The record appears in the “Task Distribution Editor” table. 
49. In the navigation tree on the left, click on “Generators” 
50. For each generator in the “Generator Table Editor” table, change all “Total Generated” values to 

be half of what they are. (i.e. if the value is 200, set the new value to be 100) 
51. For each generator in the “Generator Table Editor” table, change all “Time Distribution” values 

to be “EarlierManufacturing”. 
52. Use the “+” button to add two more similar generators that use LaterManufacturing as their 

distribution.  
53. For the first new generator, double click on the “Set Attributes” cell to pop up a dialog.  
54. In that dialog, click the “+” button.  
55. Click on the “Attribute” value and choose goToWarehouse from the drop down. Set the “New 

Value” to be true.  
56. Click ok  
57. Repeat steps 51-54 for the second newly created generator. ,  
58. Return to the Course of Action diagram.  Click on one of the nodes in the middle of the process.  
59. Highlight the “AND” node in the Step Conditions Editor and click the “+” button above it. 
60. In the dialog that pops up, choose goToWarehouse for the “Attribute”. Set the “Value” to false. 
61. Click the OK button. 
62. Above the Course of Action diagram, click “Create Step” 
63. Click somewhere in the diagram and choose “IT Travel to Warehouse” in the dialog that pops up. 

This will create a node in the diagram. 
64. Above the Course of Action diagram, click “Create Links” 
65. Click on “Go to Warehouse” and then click on one of the existing nodes. 
66. Click on “Depart Node B” and then click on “Travel to Warehouse” 
67. Click on “Depart Node A” and then click on “Travel to Warehouse” 
68. Above the Course of Action diagram, click “Select and Move” 
69. Click the “Travel to Warehouse” Node 
70. Expand the top node in the Step Conditions Editor. 
71. Highlight the “AND” node. 
72. Click on the “OR” button above the editor. This will add a new item to the tree.  
73. Drag the condition “Depart Node B completed = true” to the “OR” node. 
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74. Drag the condition “Depart Node A completed = true” to the “OR” node. 
75. Highlight the “AND” node one more and click on the “+” button above the editor. 
76. In the dialog that pops up, choose goToWarehouse for the “Attribute”.  Set the “Value” to true. 
77. Click the OK button. 
78. In the Course of Action diagram, click on the node that was connected to “Go to Warehouse”. 
79. In the Step Conditions Editor, highlight the “AND” node. 
80. Click on the “OR” button above the editor. This will add a new item to the tree.  
81. Drag the condition “<Selected node> completed = true” to the “OR” node. 
82. Drag the condition “Go to Warehouse completed = true” to the “OR” node. 
83. In the menu bar, click Simulation -> Save and Run  
84. View the various tables and graphs for results. 

 
Exercise 4: Separate Installations 

1. If it is not already open, File-> Open the demo item from Tutorial 3. 
2. In the navigation tree on the left, right click on the top installation node and choose “Create new 

installation by copying <Installation Name>” 
3. In the dialog that pops up, enter NodeBManufacturer as the name and click OK. Note the new 

installation is added to the tree.  
4. Right click on the first installation node once more and choose “Create new installation by 

copying <Installation Name>” 
5. In the dialog that pops up, enter NodeAManufacturer as the name and click OK. Note the new 

installation is added to the tree. 
6. In the navigation tree on the left, click on the top node.  
7. Above the lowest table that appears, click the “+” 
8. In the dialog, enter LeaveNodeB as the name. 
9. For the “Source” choose NodeBManufacturer and click the OK button. A new record will appear 

in the table.   
10. For this new record, set the “Time Interval” to 1.0 and the “Time Units” to seconds.  
11. Click the “+” button once more.  
12. In the dialog, enter LeaveNodeA as the name. 
13. For the “Source” choose NodeAManufacturer and click the OK button. A new record will appear 

in the table.   
14. For this new record, set the “Time Interval” to 1.0 and the “Time Units” to seconds.  
15. In the navigation tree on the left, click on the Generators node under NodeBManufacturer.  
16. In the Generator Table Editor, select the generator with the attribute “manufacturer = NodeA” 

Click the “-“button to delete that row.  
17. In the navigation tree on the left, click on the NodeBManufacturer->Plans-><ProcessName>-

>Process to bring up the NodeBManufacturer Course of Action diagram. 
18. Delete all nodes EXCEPT for the Depart Node B node.  When prompted, agree to delete the 

associated task.  
19. In the navigation tree on the left, click on the NodeBManufacturer->Tasks->IT Depart Node B 

node. 
20. Above the lower table, select the “Attributes Set” tab. 
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21. Above the “Attributes set by task” table, click on the “+” button. This will add a row to the 
bottom of the table.  

22. Set the “Attribute” of this new row to “movement” 
23. Set the “New Value” to LeaveNodeB. 
24. Above the “Attributes set by task” table, click on the “+” button once more. This will add a row 

to the bottom of the table.  
25. Set the “Attribute” of this new row to “depart” 
26. Set the “New Value” to true. 
27. In the navigation tree on the left, click on the Generators node under NodeAManufacturer.  
28. In the Generator Table Editor, select the generator with the attribute “manufacturer = NodeB” 

Click the “-“button to delete that row.  
29. In the navigation tree on the left, click on the NodeAManufacturer->Plans-><ProcessName>-

>Process to bring up the NodeAManufacturer Course of Action diagram. 
30. Delete all nodes EXCEPT for the Depart Node A node.  When prompted, agree to delete the 

associated task.  
31. In the navigation tree on the left, click on the NodeAManufacturer->Tasks->IT Depart Node A 

node. 
32. Above the lower table, select the “Attributes Set” tab. 
33. Above the “Attributes set by task” table, click on the “+” button. This will add a row to the 

bottom of the table.  
34. Set the “Attribute” of this new row to “movement” 
35. Set the “New Value” to LeaveNodeA. 
36. Above the “Attributes set by task” table, click on the “+” button once more. This will add a row 

to the bottom of the table.  
37. Set the “Attribute” of this new row to “depart” 
38. Set the “New Value” to true. 
39. In the navigation tree on the left, click on First installation->Generators 
40. In the Generator Table Editor, highlight each generator in turn and click the “-“ button to delete 

it. 
41. In the navigation tree on the left, click on First installation->Plans-><Plan name>->Process 
42. In the course of action diagram, delete the “Depart Node A” node. When prompted, agree to 

delete the associated tasks. 
43. In the course of action diagram, delete the “Depart Node B” node. When prompted, agree to 

delete the associated tasks. 

NOTE: Steps 44-70 are intended as an exercise to show the use of the GUI. The contents of the steps 
will not affect the end simulation results and thusly are optional. Please skip to step 71 if you simply 
wish to review the results. 

44. In the navigation tree on the left, click on First installation->Entity Types->TestEntity.  
45. Select the “Flow Attributes” tab over the lower table.  
46. Click the “+” button above the Additional Attribute Table Editor. This will add a new record to 

the bottom of the table.  
47. Set the “Name” on this new record to: Depart Node B Completed. Set the “Type” to be Boolean. 

Set the “Default Value” to be false. 
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48. Click the “+” button above the Additional Attribute Table Editor. This will add a new record to 
the bottom of the table.  

49. Set the “Name” on this new record to: Depart Node A Completed. Set the “Type” to be Boolean. 
Set the “Default Value” to be false. 

50. In the navigation tree on the left, click on First installation->Plans-><Process Name>->Process 
51. In the course of action diagram, click on one of the original nodes. 
52. Click on the top level node in the Step Conditions Editor. 
53. Click the “AND” button to add an AND node. 
54. Highlight the “AND” node and click the “OR” button 
55. Highlight the OR node and click the “+” button 
56. In the popup, choose “Depart Node B Completed” as the “Attribute” and choose true as the value.  
57. Click the OK button.  
58. Highlight the OR node once more and click the “+” button 
59. In the popup, choose “Depart Node A Completed” as the “Attribute” and choose true as the value.  
60. Click the OK button.  
61. In the course of action diagram, click on the “Go to Warehouse” node. 
62. Click on the top level node in the Step Conditions Editor. 
63. Click the “AND” button to add an AND node. 
64. Highlight the “AND” node and click the “OR” button 
65. Highlight the OR node and click the “+” button 
66. In the popup, choose “Depart Node B Completed” as the “Attribute” and choose true as the value.  
67. Click the OK button.  
68. Highlight the OR node once more and click the “+” button 
69. In the popup, choose “Depart Node A Completed” as the “Attribute” and choose true as the value.  
70. Click the OK button.  
71. In the menu bar, click Simulation -> Save and Run  
72. View the various tables and graphs for results. 
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